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Reporting Problems 

If you have a problem or question about DESKPAK Desk Accessories you may 
call us at (404) 928-4388. We will be glad to help in any way we can. This is a free 
service for registered users only. 

Customer support hours are whenever you feel like calling, although you may 
reach a machine instead of a person if you call at a late hour. If the lines are busy 
or unattended just leave a recorded message and we will get back to you as 
quickly as we can. Make sure when you call that you carefully prepare your 
questions and problems before-hand. It would be very helpful if you could tell us 
how to recreate the problem, although we realize this is not always possible. 

If you would rather not phone. or your question or problem is not urgent (hal). just 
write. You will get a prompt, personal reply with answers to your questions and 
solutions to your problems. 

You can also contact us via MCI Mail™ using your modem. The 10 to send 
messages to is 'SIMPLE'. 

Simple Software Systems International, Inc. 
4612 North Landing Dr. 
Marietta, Georgia 30066 

Registration Card 

It is very important that you send in the registration card. We realize that sending 
in registration cards is not the most exciting thing to do, but it is V E R Y 
IMPORTANT that you do so. We will not be able to notify you of updates or 
additions if you do not. If there is something you'd like to see added to a desk 
accessory, let us know that tool 

Customer support is for registered owners only. Make sure you send in your 
registration card. 
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Preface 

Welcome To DESKPAK 

DESKPAK is a set of New Desk Accessories (or simply NDAs) created to make 
working on your Apple JIGS more productive and enjoyable. DESKPAK desk 
accessories were designed to work hand-in-hand with your Apple JIGS programs 
and provide new features that were previously available only on the Apple 
MacintoshTM. 

About Desk Accessories 

NDAs are very useful mini-applications which can be accessed from the a menu 
within any program that supports them. NDAs can greatly enhance the programs 
you are using by providing functions that they may lack. For example, NDAs such 
as a Add DA a, Blackout, Times 3 and Password provide enhancements 
to the entire GS operating environment. There are two games for your 
entertainment and amusement. 

The Apple JIGS supports two types of desk accessories. The first, Classic Desk 
Accessories (or CDAs), are accessed from the JIGS control panel. They use the 
'old style' of text-based interface. Although useful, they generally lack functions 
and can only be run one at a time. 

The other type of accessory is the New Desk Accessory (or NDA). NDAs are 
equivalent to desk accessories found on the Macintosh. Many NDAs can occupy 
the Desktop concurrently and can freely exchange information with each other or 
with the current application. NDAs are found under the a menu (the first item on 
the program's menu bar). The Apple IIGS menu system supports a maximum of 
15 displayable accessories under the a menu (DESKPAK's a Add DA a 
accessory removes this limitation and provides access to 249 desk accessories). 

1 
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DESKPAK DESK ACCESSORIES 

Both CDAs and NDAs must be in the 'DESK.ACCS' folder (which is in the 
'SYSTEM' folder) of the disk that you start your Apple JIGS with. When the disk is 
started up (or 'booted'). the desk accessories are automatically loaded into 
memory and made ready to use. 

Since desk accessories are designed to take up a minimal amount of disk and 
memory space, you shouldn't meet with any problems. If, however, you have 
limited disk or memory space, you should only install those accessories you 
intend to use frequently and either remove or disable all others (the 
• Add DA • accessory will allow you to install any NDA from any disk or folder 
and will help you with memory and disk space limitations). 

About Graphics Modes 

The Apple JIGS presently supports two Super High Resolution graphics modes 
called 320 mode and 640 mode. Programs written for the IIGS can use either of 
these modes and some even use both! The DESKPAK desk accessories were 
designed to work properly in both modes. 

Program Guidelines 

Guidelines exist, written and distributed by Apple Computer, for the smooth and 
successful operation of programs running on the Apple IIGS. These guidelines 
cover all aspects of the system and program developers are expected to follow 
them. Each accessory in DESKPAKwas written to follow these guidelines. 

From a program's point of view, desk accessories are fairly simple to support. If 
you have purchased a program that doesn't support desk accessories, or 
behaves erratically with desk accessories installed, you should call or write the 
company and request they fix the problem. If they don't know how to fix the 
problem, tell them to call us. We're always willing to receive calls from oth~r 
program developers with questions about supporting our desk accessories. 

2 
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About The Manual 

Assumptions 

This manual assumes that you know how to use the mouse, how to select items in 
a menu bar, how to use the keyboard, how to set the Apple IIGS Control Panel 
options, and other basics found in the Apple IIGS manual that came with your 
system. 

You should know how to use the Apple IIGS Finder (included with DESKPAK) to 
copy files and format disks or be able to operate some other copy program. You 
will have to use the Finder or another copy program to make copies of the 
DESKPAKprogram disk and install the accessories. The. and <3 symbols are 
used to represent the option and command keys, respectively. 

Chapters 

Chapter 1 details the simple procedure for installing the DESKPAK desk 
accessories on your·program disks. The procedures are straight-forward and 
assume you know how to use the Apple IIGS Finder. 

Chapters 2 through 20 describe each desk accessory in detail. These chapters 
contain the bulk of the manual and should be referred to when a question 
regarding a particular desk accessory arises. 

Chapter 21 presents some ideas on how you can maximize your productivity. 
Practical uses for many of the accessories are given to get you thinking about 
how the DESKPAK desk accessories, your programs, and the way you work can 
be effectively integrated. 

The Appendices 

The Appendices contain information you may need, such as using desk 
accessories with limited memory, how they behave with various programs, 
technical information, and important system parameters. 

3 
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The Glossary 

It is important that you understand the terms used in this manual. If the text 
becomes confusing or hard to grasp, find what word or words you don't 
understand and look them up in the glossary or a good dictionary. 

The Index 

Finally, there is a detailed index at the end of the manual that will help you locate 
the information you need quickly. We have made every effort to put as many 
cross references as possible so you don't have to search for the 'right' word. 

Backup Copies 

Before you do anything else with your DESKPAK program disk, you need to 
make a copy of it and store the original disk in a safe place away from stray 
electrical fields, excessive heat or cold, or anything else that may adversely affect 
the disk. If something happens to the extra disk, you will always have the original 
as a backup. Remember, any copies you make are for your personal use and are 
not to be loaned-out or given away. 

You may already know how to make a backup copy using the Apple IIGS Finder. If 
you do, make the copy now. If you are not sure how this is done, refer to the 
Apple JIGS Owners Manual that contains information on making copies of disks, or 
use a copy program you are already familiar with. 

You can use the backup copy of DESKPAK for installing the desk accessories 
on your program disks and as a startup disk for your Apple JIGS. That way, you will 
have the Finder to launch all your programs and you will be sure that you are 
running the latest system software from Apple Computer, Inc. GS/OS (system 
disk 4.0) comes on 2 disks. The AppleTalk, printer and disk-drive drivers are not 
included with DESKPAK - you should get these from your dealer. 

4 
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Chapter 1. Installation 

NOTICE! The. Add DA • accessory, described in Chapter 2, allows you to 
use desk accessories located on any disk without actually installing them on your 
startup disk. You can then decide which DESKPAK desk accessories to install 
on your startup disks or simply use. Add DA • to access them! 

We highly recommend using • Add DA • as it gives you access to any desk 
accessory rocated on any disk. Refer to Chapter 2 for a detailed description of 
this desk accessory. 

New Desk Accessories will only run under ProDOS 161M or GS/OS1M on an Apple 
JIGS. Additionally, the program must support New Desk Accessories. Most 
applications written for the Apple JIGS support them. If the program has a menu 
bar and an. menu, like the one found in the Finder, it will probably support them. 

'Boot' Disks 

When the Apple JIGS first starts up (called 'booting'), it looks for all the desk 
accessories in the '/SYSTEM/DESK.ACCS' folder on the startup disk (the 'boot 
disk') and loads them into memory. If you always boot your Apple JIGS with the 
same startup disk, the desk accessories should be installed on that disk. Each 
time you boot with this disk, the accessories will be loaded into memory and ready 
to use. If you use a number of startup disks (maybe one for each of your JIGS 
programs) you will need to install the desk accessories on each disk. 

The DESKPAK disk includes the latest version of GS/OS1M and the FinderTM and 
has a copy of • Add DA • in the 'DESK.ACCS' folder. It can be used as your 
standard startup disk. If you plan to go this route, you don't need to do anything 
else and can skip installation completely. This is the recommended method. 

5 
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One word of caution: if more than 15 or so desk accessories appear under 
the. menu, it will extend below the bottom of the screen and the 'hidden' 
accessories will not be accessible. • Add DA • eliminates this problem and 
provides access to the maximum 249 NDAs permitted. 

The DESKPAK desk accessories are located in the folder named 
'DESKPAK.ACCS· on the DESKPAK program disk and not in the 
'DESK.ACCS' folder as one might expect. 

If you are already familiar with installing desk accessories, decide whether you 
wish to install. Add DA • alone or with other accessories and do that now. 

DESKPAK Installation - Finder 

NOTE: The DESKPAK program disk automatically runs the Finder and opens 
the 'DESKPAK.ACCS' folder when booted. This folder contains all of the 
DESKPAK desk accessories. 

To install the accessories on a program disk or hard disk, you need to move the 
accessories you want from the 'DESKPAK.ACCS' folder on the DESKPAK disk 
to the 'DESK.ACCS' folder of your program disk. The 'DESK.ACCS' folder will 
always be found in the 'SYSTEM' folder on the disk. Do not install NOAs on a disk 
that doesn't have a SYSTEM folder, as it isn't a boatable disk. 

DESKPAK includes a special icon for NOAs that looks like those shown in 
Figure 1. To copy them, simply drag the icon, with the mouse, to the 
'OESK.ACCS· folder on your program disk or hard disk. You may also copy the 
entire contents of the 'OESKPAK.ACCS' folder to your program disk or hard disk 
by choosing 'Select All' from the 'Special' menu in the Finder (Figure 1) and 
dragging all of them simultaneously. 

The following instructions refer to 'YOUR. DISK' as the disk you will be 
transferring the desk accessories to. 
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~ ~ .. .. .. 
ADD.DA APPOIHTMEHTS 

~ ~ ~ ~ ~ .. .. .. .. . . .. .. .. .. .. 
CALENDAR CLIP. BOARD COHCEHTRATE FILEJOOLS HIHLDB 

~ ~ ~ ~ .. 
~~ .. . . .. .. 

NOTEPAD PASSWORD PRINT.IT PUZZLE 

~ ~ ~ .. .. . . .. .. .. 
SIHPLE.StRAP SUPER.SCRAP TIMES.3 

Figure 1. The Apple IIGS FinderTM with DESKPAKicons. 

Installation With One 3.S-lnch Drive 

1. Insert the DESKPAKprogram disk in the disk drive. 

2. Turn on the Apple JIGS. The Finder Desktop will appear and the window 
containing the desk accessories will automatically open. If the window does 
not automatically open, double-click on the DESKPAK disk icon, then 
double-click on the 'DESKPAK.ACCS' folder. 

3. Pull down the 'File' menu and choose 'Select All'. All of the DESKPAK 
NDA icons will be highlighted. If you wish to copy only a few of the 
accessories to YOUR.DISK, hold down the Shift key while clicking on each 
of the desired accessories. 

4. Eject the disk and insert YOUR.DISK in the disk drive. 

5. Double-click on YOUR.DISK icon. 
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6. Double-click on the 'SYSTEM' folder on YOUR.DISK. 

7. Double-click on the 'DESK.ACCS' folder on YOUR.DISK. 

8. Drag the desk accessory icons to the 'DESK.ACCS' folder on YOUR.DISK. 

9. Follow the directions from the Finder when it asks you to switch disks. 

The DESKPAK desk accessories are now installed on YOUR.DISK! From now 
on, when you turn on or re-boot your Apple IIGS with YOUR.DISK, the 
accessories will be accessible under the. menu. 

Installation With Two 3.5-lnch Drives 

1. Insert the DESKPAKprogram disk in the first disk drive. 

2. Insert YOUR.DISK in the second disk drive. 

3. Turn on the Apple IIGS. The Finder Desktop will appear and the window 
containing the desk accessories will automatically open. If the window does 
not automatically open, double-click on the DESKPAK disk icon, then 
double-click on the 'DESKPAK.ACCS' folder. 

4. Pull down the 'File' menu and choose 'Select All'. All of the DESKPAK 
desk accessory icons will be highlighted. If you wish to copy only a few of 
the accessories to YOUR.DISK, hold down the Shift key while clicking on 
the desired accessories. 

5. Double-click on YOUR.DISK icon. 

6. Double-click on the 'SYSTEM' folder on YOUR.DISK. 

7. Double-click on the 'DESK.ACCS' folder on YOUR.DISK. 

8. Drag the selected desk accessory icons from the DESKPAK disk to the 
'DESK.ACCS' folder of YOUR.DISK. 

8 



DESKPAK DESK ACCESSORIES 

The DESKPAK desk accessories are now installed on YOUR.DISK! From now 
on, when you turn on or re-boot your Apple IIGS with YOUR. DISK, the 
accessories will be accessible under the. menu of any program launched from it. 

Installation on a Hard Disk or a RAM Drive 

1. Set-up your Apple IIGS to boot from your 3.5-inch drive, insert the 
DESKPAK disk, and turn on or re-boot the computer. 

The Finder Desktop will appear and the window containing the desk 
accessories will automatically open. If the window does not 
automatically open, double-click on the DESKPAK disk Icon, 
then double-click on the 'DESKPAK.ACCS' folder. 

2. Pull down the 'File' menu and choose 'Select All'. All of the DESKPAK . 
desk accessory icons will be highlighted. If you wish to copy only a few of 
the accessories to YOUR.DISK, hold down the Shift key while clicking on 
the desired accessories. 

3. Double-click on the icon representing your hard drive or RAM drive. 

4. Double-click on the 'SYSTEM' folder on your hard drive or RAM drive. 

5. Double-click on the 'DESK.ACCS' folder on your hard drive or RAM drive. 

6. Drag the desk accessory icons selected from the DESKPAK disk to the 
'DESK.ACCS' folder of your hard drive or RAM drive. 

7. Enter the Control Panel and reset the boot drive to your hard drive or RAM 
drive. 

The DESKPAK desk accessories are now installed on YOUR.DISK! From now 
on, when you turn on or re-boot your Apple IIGS with YOUR.DISK, the 
accessories will be accessible under the. menu of any program launched from it. 
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DESKPAK Installation - Copy Program 

You may prefer using another copy program to install the desk accessories. Refer 
to the manual that came with the copy program you will be using for details. 

After Installation 

The DESKPAK desk accessories that are installed on your boot disks will be 
loaded into memory and ready to go. Just pull down the '* menu on any IIGS 
program and select the DESKPAK desk accessory you want to use. 

Default Files 

The DESKPAK accessories which maintain data files (Notepad, Super 
Scrap, etc.) allow you to save and load an unlimited number of files anywhere on 
your disks. This flexibility is complimented by the ability·to load a 'default file' 
when the accessory is first run. In order for the default file system to work, there 
must be a folder named 'DESKPAK' in the 'SYSTEM' folder of your boot disk. 
This 'DESKPAK' folder will contain the default data files for DESKPAK NDAs. 
The chapters describing how to use the individual NDAs will provide more details 
on what to name the default file and how to use it. 
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Chapter 2. • Add DA • 
• Add DA • is a powerful desk accessory designed to help you 'manage' your 
NDAs more efficiently. In fact, it is the only new desk accessory you need under 
your. menu (actually, in the 'DESK.ACCS' folder). With it, you can load any desk 
accessory from any disk or folder and use it immediately. For instance, if you 
need to use File Tools, another DESKPAK NDA, simply load it with 
• Add DA.. Or, if you are in your word processor and need a scrap from one 
of Super Scrap's unlimited number of scrapbooks, you can quickly load it and 
carry-on your work. The newly loaded desk accessories will remain available until 
you re-boot the computer. 

In addition to the convenience of being able to load any desk accessory any 
time, you will notice a marked improvement in 'boot time' if only. Add DA • is 
installed. You don't have to have copies of NDAs on all of your start-up disks any 
more - • Add DA • will do the work for you! 

CJ iRdd DR i 
Humb!r of Loaded HDAs : q 

i Add DA i I{}-
.:111 1 

Disk Cache 
Scr!en Saver 

~ 

( Op!n60 ~( Load6L ) 

Figure 2. • Add DA • 

11 



DESKPAK DESK ACCESSORIES 

Select New Desk Accessors: 
-8 ISslDeskpok.Accsl 

Add.Da ( Disk ) 
D Appointments 
D Ascii.Chart ( Open ) 

( Close ) 

( Concel ) 

Figure 3. • Add DA • accessory selector window . 

• Add DA. also solves the 'too many NDAs' problem since the. menu can 
only display up to 15 NDAs, all others would be unusable. Since DESKPAK 
includes 18 NDAs, you wouldn't be able to use all of them at one time . 
• Add DA. provides a scrollable window that can display up to 249 desk 
accessories. A double-click is all it takes to run any loaded desk accessory. 

USing '* Add DA '* 
Selecting • Add DA • from the • menu will open the window shown in Figure 
2. To select a desk accessory, double-click on it's name, or select it and click in 
the Open button (or '0 O')or press Return. Choose Load (or '0 L') to access 
the accessory 'selector window' shown in Figure 3. The accessory selector 
window will only display New Desk Accessories and operates just like any other 
'Get File' window you've used before. To change disks, click in the Disk button, 
or press the Tab key. To close a folder, click in the Close button or press Esc. 

The Cancel button or '0 .' will cancel the operation. 
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After selecting the desk accessory to load in, • Add DA • will load it in and put it 
as the next item under the. menu, allowing you to open and use the desk 
accessory as you would normally. If the accessory was loaded successfully, the 
menu bar will flash one time. 

Tips 

REMEMBER THAT THE DESKPAK DESK ACCESSORIES ON THE 
DESKPAK PROGRAM DISK ARE IN THE 'DESKPAK.ACCS' FOLDER, 
NOT THE 'DESK.ACCS' FOLDER. 

• Add DA • will load as many desk accessories as you want, if you have 
the extra memory. If there is not enough memory to load a desk accessory, 
• Add DA • will flash the menu bar and beep. 

• Add DA • only loads New Desk Accessories. If you are not sure about 
the different kinds of desk accessories, please read the section of the 
Preface that describes New Desk Accessories or refer to your Apple JIGS 
Manual. 

• Add DA. assumes that the program uses a standard. menu. 

It is best to keep all your New Desk Accessories in one place. Try keeping 
them on one disk or in one folder, such as the way DESKPAKkeeps them 
in the 'DESKPAK.ACCS' folder. That way, you will always know where to 
find theml 

• If you wish, you may place other desk accessories in the 'DESK.ACCS' 
folder to be loaded at boot time along with. Add DA •. 

Advanced Tip: the Finder's 'Get Info' item under the 'File' menu allows 
you to deactivate an NDA by checking the 'Inactive' box. This feature allows 
you to keep YQur all of your NDAs in the 'DESK.ACCS' folder but only load 
the ones that are active! 
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Chapter 3. Appointments 
DESKPAK's Appointments is a perpetual calendar desk accessory that allows 
you to enter appointments for any date from January 1940 to Oecember 2039. 
Appointments has its own private menu bar with advanced features such as 
loading or saving any number of different appointment calendars located on any 
disk and information regarding the currently loaded calendar. 

Default Appointments 

Unlike other accessories of this type, Appointments is NOT tied to your boot 
disk. Other calendar accessories require that your boot disk always remain in your 
disk drive so the accessory can read in its appointment file. Appointments first 
looks for a calendar file named 'Appointments' in the 'OESKPAK' folder in the 
'SYSTEM' folder on boot disk. If a file is found, it is automatically loaded in, if not, 
Appointments acts as if you are starting a new appointment calendar file and 
sets the title bar to 'Untitled'. Instructions on how to access any appointment file 
will be covered in the section on Get •.•. 

Using Appointments 

When Appointments first opens, it will show the current month and year. the 
current date will appear in boldface (see Figure 4.) The title bar will be set to the 
filename of the default file (,AppOintments') or 'Untitled' if no default file was 
found. Any day that contains an appointment has a ...J mark next to it. 
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0 Appointments 
i Fil! Deleh 

======:Mov!m.!rlgBB====== 
Sun Hon rue Wed Thu Fri Sat 

1 2 3 ~ 5 
6 7 B 9 16 11 12 

13 1~ 15 16 17 18 19 
,,211 21 22 23 2~ 25 26 

27 28 29 311 

I Jon feb Har I Apr HOll Jun Yr-
I Ju 1 Aug Sep Oct Mov Dec Yr+ 

Figure 4. Appointments. 

To enter an appointment, click on the desired day. A window will appear (see 
Figure 5.) allowing you to enter your appointments from 8 -am to 5 pm. The text 
entry works just like a word processor. To move to a different time, click in the box 
representing the desired time, or use the Tab key, and continue entering your 
appointments. 

When you are through entering appointments, click on the Ok button or press 
Return to save the new appointments or Cancel to cancel all the entries. If Ok 
was selected, the day that the appointments were entered for will have a ...j mark 
next to it. 

To enter another appointment, or view existing appOintments entered for a 
ch~cked day, click on that day. The appOintment window will be re-displayed, 
allowing you to enter more appointments or edit the existing appointments. 
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Appointllrnts for 21 Novrmber 1988 

8011 Hrn with Hike about DESKPAK 
9011 
10011 
11011 
12P11 Lune. break!! 
1P11 
2P11 
3 PII 
~PII Pick-up disks 
5P11 

( Caned) m 
Figure 5. Appointment Window: Simply fill in the blanks ... 

To move to a different month, click in one of the Jan ••• Dec buttons below the 
calendar area. To change years, click in the Yr+ or Yr- buttons. Clicking on the 
lined 'month and year' bar will return you to the current month and year. 

'* Menu 

Choosing the. menu in the Appointments menu bar allows you to select 
About •.• or Info •••. 

About .•. 

The About ••• item displays a window containing the copyright, version number, 
and other information about this accessory. You can also select this item using 
the keyboard equivalents '0 ?' or '0 1'. 
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Info ... 

The Info ... item displays a window containing information pertinent to the 
accessory itself, such as the days before the current month that contain 
appointments. You can also select this item using the keyboard equivalent '0 I'. 

File Menu 

The File menu in the Appointments menu bar is where you can Get ••• and 
Save ... appointment calendars. You can also start a New calendar, or Delete 
All the appointments in the current appointment calendar. 

New 

New starts a new apPointment file. If you made cha!1ges to the current 
appointment file, you will be asked if you wish to save it to disk. A description of 
the 'Save File' window can be found below under the Save... menu item. 
Appointments' title bar will change to 'Untitled', indicating a new appointment 
file. 

Get ... 

With Get ... or '0 G'. you can retrieve an appointment calendar from any disk. If 
you made changes to the current appointment file, you will be asked if you wish to 
save it to disk. Click in the Ok button to bring up a 'Save File' window, or Cancel 
to discard the changes made to the current apPointment file. A description of the 
'Save File' window can be found below in the Save... menu item. A 'Get File' 
window will appear, allowing you to search through different disks and choose an 
appointment calendar. To select an appointment calendar or open a folder, 
double-click on the file name or select the file and click in the Open button or 
press Return. To change disks, click in the Disk button or press the Tab key. 
The Close button or Esc key closes the folder. If you change your mind, click in 
the Cancel button or press the key combination '0 .' . 
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Save ... 

With Save .•• or '0 S' you can save the current appointment file to any disk. A 
'Save File' window will appear, allowing you to specify the name of the file and 
what disk to save it to. Click in the Disk button to change disks. To create a new 
folder, type in a name for the folder in the Save Calendar As box and click on 
the New Folder button. Open a folder by double-clicking on the folder name or 
selecting the folder and clicking in the Open button. Simply click in the Close 
button to close the folder. Save the appointment calendar file with the name 
specified in the Save Calendar As box by clicking in the Save button or 
pressing Return. To change the name the appointment calendar will be saved 
as, type a new name in the Save Calendar As box and click in the Save 
button. If you change your mind about saving the calendar file, click in the 
Cancel button or press '0 -'. You will be asked if you want to replace a file that 
already exists. 

Remember: save the file as 'Appointments' in the 'DESKPAK' folder to make it 
the default appointment calendar file. 

Delete Menu 

Delete All ••. 

Delete currently contains only one item, Delete All.... This item will allow you 
to delete all appOintments' in the current appointment calendar. Once the 
appOintments for a calendar are deleted, they are lost forever, unless you had 
previously saved them to disk. 

Closing Appointments 

When you are finished using Appointments click in the 'Close Box'. If you 
made changes, you'll be given a chance to save them. 
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Tips 

20 

It is always a good idea to periodically Save the appointments as you enter 
. them. That way, if something should occur (like a power outage) you won't 
have to re-enter everything. Just press '0 S' to quickly save the 
appointment file. 

It will be easier to find an appointment file if you keep all of them in one 
place and give them descriptive names like 'Mikes.Appts'. Try setting-up a 
disk for appointment calendars, or create a new folder, such as 'Calendar' 
in the 'OESKPAK' folder. 

If you want to make a different appointment calendar the default calendar, 
open the 'Appointments' file and save it with a different name, then open 
the appointment calendar you want as the new default file and save it as 
'Appointments' in the 'OESKPAK' folder, replacing the current one. You 
can also use File Tools to simply rename the two appointment calendars. 

Appointments shouldn't cause memory problems because the 
appointment files do not take-up much memory. If you entered an 
appointment for every hour of every day for an entire month, the file would 
take-up approximately 9k of memory. If you are short on memory, delete all 
notes for previous days. 

The • menu on Appointments' private menu bar will not contain desk 
accessories. That right is reserved for the program's colored. menu. 

The appointment calendar files are saved as Binary files (type $00). If you 
attempt to read in files not created by Appointments, expect 
unpredictable results. 

Make sure you back-up your appointment calendar files as you would any 
other important data. 
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Chapter 4. ASCII Chart 

ASCII, which stands for American Standard Codes for Information Interchange, 
was developed to maintain a standard among communicating devices like 
teletype machines. These codes were carried-over to the microcomputer world 
and are used in a variety of ways, like sending characters to printers and modems. 
The computer interprets the codes and carries-out their intended functions. For 
instance, if a computer receives the ASCII code representing a Control G, it 
knows that it should beep its internal speaker. 

Programmers need to know the ASCII codes like the back of their hands. Most do 
not because they can refer to a table containing a description of the codes. The 
ASCII Chart is intended as a programmer productivity and educational tool. It 
provides anyone needing to know ASCII values a ready reference. The ASCII 
Chart can also be used to determine the codes for special characters like the '* 
symbol. There are many 'hidden' characters in the Apple IIGS character fonts and 
ASCII Chart will help you find them! 

Using the ASCII Chart 

When the ASCII Chart is opened it presents the 256 ASCII codes, 8 at a time, 
and shows the decimal, hexadecimal and mnemonic character representation for· 
each ASCII code. You can look at all 256 of the codes by means of the scroll bar 
on the right hand side of the window. Click in the 'Up Arrow' region to move up 
one line at a time, the 'Down Arrow' region to move down one line at a time, the 
'Page Up' region to move up an entire page at a time, or the 'Page Down' region 
to move down an entire page at a time. 
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Figure 6. ASCII Chan: Use the scroll bar to move through the chart. 

To move to a relative position within the chart, drag the thumb up or down. 
Dragging the thumb to the very bottom of the scroll bar will display the last page, 
while dragging the thumb to the top of the scroll bar will display the first page of 
the chart. Pressing a key combination will also scroll the display to the relative 
position - a feature useful for determining what character speCial key 
combinations print. 

To view the copyright information for this desk accessory, press the '0 ?' or '0 I'. 
When you are through using the ASCII Chan click in the 'Close Box', or leave 
the window opened on the Desktop for ready reference. 
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Chapter 5. Blackout 

Blackout will add years of .life to your Apple JIGS monitor. It was designed to 
solve the problem known as 'screen burn'. An image left on the screen for 
extended periods of time can permanently 'burn' into it. An example of such an 
image is the ever-constant menu bar. 

Blackout allows you to instantly black-out the entire screen and border while 
you're away from your computer. Blackout will also monitor your activity and if a 
specified time period passes without a key press or mouse movement, it will . 
automatically black-out the screen. While the screen is blacked-out you can 
specify if you would like the border to flash on and off every 15 seconds. 

o Blackout 

Figure 7. Blackout: add years of life to your monitor ... 
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Using Blackout 

Activating Blackout 

The Blackout window is shown in Figure 7. Blackout is activated by either 
clicking on the On or Now buttons in the Activated box. On installs the time 
delay set in the Delay box and causes Blackout to wait patiently until the 
specified time interval passes without key or mouse activity. The Off button 
disables Blackout. Now does exactly what its name implies. it blacks-out the 
screen NOW! 

Blackout saves its parameters on the start-up disk when you close the window 
with the Close Box. It will automatically be instaiied and run if you re-boot your 
computer or switch applications! 

Intervals 

You may specify the amount of time that passes before the screen is blacked-out. 
Choose a delay value in the Delay box by clicking in its button. The default 
button is 1 minute. 

Border Flash 

Another unique feature of Blackout is the border flash. When this option is 
chosen (On selected). the screen border will flash on and off once every 15 
seconds. The flash will let you know that everything is still working OK and that 
Blackout is doing its job. 
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Recovering The Screen 

To recover the blacked-out screen, simply move the mouse or press a key on the 
keyboard. The key press will not be passed to your application. 

Turning It Off 

Blackout may be turned-off anytime by choosing Off from the Activated box. 

Closing Blackout 

To close Blackout, click the mouse in the 'Close Box' and the window will be 
removed from the Desktop. Blackout does not need to be on the Desktop to 
work. If you have activated Blackout, it will black-out the screen when the· 
specified delay has passed. 

Background Functions 

Blackout has the ability to continue functions a program may be carrying-out. 
For instance, if you are printing a document from your word processor, the screen 
may black-out, but printing will continue. 
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Chapter 6. Calculator 

The Calculator is an electronic 'desktop' version of the familiar hand-held 
model. It contains standard math functions and several extended capabilities. 
For instance, it includes the ability to cut and paste numbers to and from 
spreadsheets, word processors and other programs. The Calculator has 
continuous memory; after you close the Calculator you can re-open it and the 
memory will be intact, even between the launching of separate programs. 

Figure 8. The Calculator: Use the Mouse or Keyboard for input. 
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Using the Calculator 

The Calculator is used much like the familiar hand-held home calculator. It can 
be used from both the keyboard and by clicking its keys with the mouse. All of 
the keys on the Apple IIGS numeric keypad perform their expected operations 
with the Calculator. Several features, such as memory and percents, do not 
have numeric keypad equivalents and must be accessed from the main keyboard. 
The Calculator can be used entirely from the keyboard! 

Cutting and Pasting 

The Cut ('0 X'). Copy ('0 C'). Paste ('0 V') and Clear ('C' or Clear key) items 
under the Edit menu perform their appointed tasks. 

Values may be Pasted into the Calculator and used as input for an operation. 
Any value previously in the display will be over-written. Cut does the same thing 
as Clear but puts the number on the 'Clipboard' for later retrieval. 

Note that you can only paste numbers into the Calculator that have been put on 
the 'Clipboard' as text. You cannot paste 'painted' text into the Calculator, 
unless the program put the number onto the 'Clipboard' as text. 

Calculator Keys 

The following are key descriptions for each function of the DESKPAK 
Calculator. We'll assume you are familiar with operating a standard calculator. 
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The + key does addition, the - key subtraction, the * key multiplication, and the 
/ key division. The • key allows insertion of a decimal point into the currently 
entered number. 

@] 
Numbers on the display can be cleared by pressing the Clear button or C key. 
The display will be erased and zeroed and all pending calculations are terminated. 
If an error is displayed, Clear will remove it. 

EI 
The +/- button or X key will change a positive number to a negative one, and a 
negative number to positive one. 

The Fix button or F on the keyboard, followed by a number, selects the number 
of decimal places you would like to have displayed. You can 'fix' the number of 
displayed places from 1 to 9, although the internal calculations are done to 
greater precision and rounded to the number of decimal places specified. 
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The M+ button or A key will add the displayed number to the number residing in 
the memory and the M· button or M key will subtract it from the memory. A 
number stored in memory is shown by a small 'm' in the upper left hand corner of 
the display. The memory will stay intact even if you close the Calculator or 
launch another program. 

Rcl is used to recall a saved value from the memory. 

Clearing Memory 

Clearing memory can be accomplished by recalling the number in memory using 
Rcl and pressing the M· button to subtract the same value from the memory. 

The Sqr button or 5 key will calculate the square root of the displayed number. 

The % button or P key will show the displayed number as a percent. 

'30 



DESKPAK DESK ACCESSORIES 

EI 
The ~ button or key will delete the last digit entered, until an operation is 
performed, then it will clear the display. It will also clear the display if an error 
occurred. 
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Chapter 7. Calendar 

DESKPAK's Calendar is a smaller and simpler version of the Appointments 
desk accessory described in Chapter 3. It is intended as a 'quick-look' calendar 
and doesn't use appointment files. It operates just like Appointments in 
Chapter 3. 

[j Calendar 

=== October mB === 
Sun Hon Tu! lied Thu Fri Sot 

1 
2 3 q 5 i 7 8 
g 10 11 12 13 lq 15 

16 17 18 19 2~ 21 22 
23 2q 25 26 27 28 29 
30 31 

It Jan Feb Har Apr Hal Jon Yr-J 
"Jul Aug 5ep Oct Hov Dec Yr+ I 

Figure 9. Calendar: A 'quick look' calendar. 
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Chapter 8. Clipboard 

The Apple IIGS system supports advanced editing capabilities based on the 'cut 
and paste' metaphor. One part of the programmer's guidelines that Apple 
advocates is the Edit menu on the menu bar. The items under this menu 
provide the capability for programs and desk accessories to 'communicate' with 
each other in a straight-forward and orderly manner. The data (text or graphics) 
that is 'cut or pasted' is moved to and from a memory 'holding' area called the 
'Clipboard'. 

Many applications do not allow you to view what is on the 'Clipboard', a necessity if 
you think you have important data on the 'Clipboard' that you might want to save 
before putting something else there. The DESKPAKCllpboard is a simple'but 
useful accessory which allows you to view the current contents of the system 
clipboard from within any program. To use it, select Clipboard from the • 
menu. 

[J Clipboard 

Figure 10. The DESKPAKClipboard. 
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When the Clipboard window is displayed, it shows the text or picture currently 
on the system clipboard. If none exists, Clipboard will be empty. 

The icon on the right-hand end of the Clipboard title bar is called the 'Zoom 
Box'. Clicking in this box expands the window to the full screen, allowing you to 
see more of the 'Clipboard'. Clicking in the 'Zoom Box' again returns the window 
to its original position and size on the screen. 

'0 ?' or '0 I' displays copyright information for Clipboard. 
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9. Concentrate 

Concentrate is similar to the game of Concentration. You probably won't 
believe that it will improve your memory and recall abilities, so let's just say it will 
provide you with hours of amusement. 

The object of the game is to find matching colored tiles by 'turning' them over in 
twos. When a match is found, the two matching tiles are removed from the· 
playing grid until the game is finally completed. You may also peek behind tiles 
(cheatl), although only 3 peeks per game are permitted. The idea is to solve the 
game in the least amount of time using the the fewest number of turns. 

Using Concentrate 

Concentrate is shown in Figure 11. Click on a tile to flip it over and display its 
color combination. The timer will not start until you make your first move. Now 
click on a second tile. If the two tiles match, they will be removed from the playing 
grid. If they do not match, remember what the color combinations looked like and 
where they were. 

Continue selecting tiles, two at a time, trying to remove them all from the playing 
grid to win the game. 

When the game is finished, click anywhere in the Concentrate window and a 
new game grid will be set up. Click in the 'Close Box' at any time to terminate the 
game. 
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Halting/Resuming 

Clicking on the Halt button will halt game play and stop the timer. The Halt 
button name will change to Resume. Clicking on the Resume button or 
selecting a tile will immediately resume play. If you activate another window on the 
desktop, the game will be automatically halted for you. To resume play, click in 
the Concentrate window again. 

Figure 11. Concentrate: Colorful Concentration. 

Peeking 

You may reveal a tile at any time by clicking on the Peek button and selecting the 
tile you wish to peek at, although you may only peek 3 times per game. After your 
third peek, the Peek button will not be selectable. Peeking does not add to 
the number of turns, though the timer will continue tracking your elapsed time. 
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Turns/Time 

The Turns button allows you to view the number of turns you've used so far to 
solve the game. The button name will change to Time, allowing you to revert to 
the elapsed time. Concentrate keeps track of both the elapsed time and 
number of turns throughout the game. 

Colors 

Concentrate uses the color palette that the current program is using. This can 
make the game more difficult if you happen to be working with a program that only 
uses 4 colors. Take advantage of this 'feature' by running Concentrate from 
your favorite 'Paint' program I The colors in Concentrate will match those of the 
color palette in the program (Shades of blue look greatl). 
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Chapter 10. File Tools 

File Tools gives you access to disks and files from any program. It will allow you 
to quickly lock, unlock, copy, delete and rename files of any type found on .any 
disk and ease the burden of keeping your disks organized. File Tools is able to 
do almost anything with a file that the Finder does, without leaving the program 
you are working in. . 

Using File Tools 

Selector Window Commands 

When you choose File Tools from the. menu, the file selector window shown 
in Figure 12 will open. As the name implies, the file selector window is used for 
selecting the file you want to lock, unlock, copy, rename or delete. 

You can choose a file or open a folder by clicking on its name and clicking on the 
Choose button (or pressing Return) or by double-clicking on it. Any open 
folder can be closed by clicking on the Close button (or pressing Esc) or by 
clicking on the pathname above the list of files. 

The scroll bar can be used to see a list of all files on the disk or in the folder. To 
move up through the list, click on the up-arrow or use the up-arrow from the 
keyboard. Scroll down the same way using the down-arrow on the scroll bar or 
keyboard. Clicking on the page-up or page-down region of the scroll bar will 
move through the list one page at a time. The thumb may be dragged anywhere 
within the list of files. 

File Tools will move from disk to disk when you click the Disk button or press 
the Tab key. All disk types, including RAM disks, are supported. 
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File Tools (c) 1981,88 SSSI- Yen 1.1J 
® ISs! 
~~.m~ ( Disk) 

( Choose) 

( CIos~ ) 

r..===.:..::.::..-_""'""'-' ( Quit) 

Figure 12. File Tools: File selector window. 

The Quit button will close File Tools and return you to the program. File 
Tools will continue to return to the file selector window until Quit is chosen. 

Operation Window Commands 

After you have chosen a file, the file selector window will close and you will be 
presented with the file operations window (Figure 13). This is where you select 
the operation you would like to perform on the file. The file operations window 
also contains information about the file - the filename, what type of file it is, the 
pathname, when the file was created, and when the file was last modified. 

The box labeled Locked will have an 'X' in it if the file is locked or will be empty if it 
is not. To lock or unlock a file, click in the 'Lock Box'. 

Delete will ask if you really want to delete the file, choose Ok if you do or 
Cancel if not. If the file is locked, you will be told so and asked if you would still 
like to delete it. Again, click on Ok to delete the locked file or Cancel to cancel 
the deletion. 
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Filename: Fisure.93 
Kind: Undefined 
Where:/Deskpok 
Creat.ed: Kov 2D, 1988 at. 1:19 PH 
Modified: Kav 20,1988 at 1:19 PM 
Dlocked 

(Delete ~ 

( COPlJ ) 

( Rename) 

( Cancel ) 

Figure 13. File Tools: File operations window. 

A file can be renamed with Rename. You will be asked for the new filename. 
Note that a legal filename must start with a letter 'A-Z' or 'a-z', followed by the 
characters 'A-Z', 'a-z', '0-9' or '.'. Also, remember that all editing functions are 
available while typing in the filename. When you are ready to rename the file, click 
on Ok to rename it or Cancel to cancel the operation. If the file is locked, you will 
be told so, and asked if you would still like to rename the file. Again, click on Ok 
to rename the locked file or Cancel to cancel the operation. 

Copy is an extremely useful command for saving copies of a file before you save 
a new (modified) version of it. Although this is a seemingly obvious command, 
many programs do not support it! When you click on Copy, a window similar to 
the file selection window will open. You may change the name of the file and/or 
create a new folder. When this window appears, just select the filename, disk and 
folder of where you want to copy the file to. Click on Continue to continue the 
copy operation, or Cancel to cancel it. 
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Additional information about File Tools: 

File Tools will always return to the file selection window after an operation. 
You must select Quit to leave File Tools. While using File Tools you 
will not be able to select other windows or items in the menu bar. 

The operations window allows you to decide which operation you would 
like to do on a file. After you select the operation, it is verified before being 
performed. You can cancel any operation, at any time, by choosing the 
Cancel button. 

If you try to delete or rename a locked file, you will be told the file is locked 
and asked if you still wish to delete or rename it. Double-check before 
selecting Ok because the file was probably locked for a reason. 

File Tools will not delete, rename or copy folders. File Tools was 
designed for files only. For folder or multiple file operations, use the 
Finder. 

The copy operation is a fast, one-pass copy utility. This is especially 
important for users with one disk drive, as they will only have to swap disks 
once. 

• In some rare instances you may not have enough memory to do a file copy 
operation. File Tools will let you know you are short on memory and abort 
the copy. 
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Chapter 11. Mini DB 

DESKPAK's mini database, or Mini DB for short, contains features found in 
more sophisticated database programs, all in one desk accessory! 

Mini DB uses 'cards'to store and display its information. Each card contains 
seven 'fields' which contain the information or data and a 'field label' describing 
what each of the fields represents. A 'stack' of cards consists of a 'card deck' -
cards containing similar information, such as recipes or addresses. A card deck . 
can have as many cards as memory permits and can be tailored to store 
information such as names and addresses, recipes, personal information, 
customer information, or any type of information that you'd like. You may have an 
unlimited number of different card decks located on any disk. 

Mini DB allows you to search for a specific card, delete a card, delete an entire 
card deck, add a card, go to a specific card, flip through cards, redefine card field 
labels, sort the card deck, and print single cards or the entire card deck. 

Most of Mini DB's functions are accessed from its private menu bar. As with 
most DESKPAK desk accessories, you can use the 'Edit Menu' commands on 
the program's menu bar to cut, copy and paste card information to the 'Clipboard', 
and information from the 'Clipboard' to a card. 

Default Card Deck 

When Mini DB is opened, it looks for a card deck named 'CARD. DECK' in the 
'DESKPAK' folder. If this default file is found, it will be automatically opened every 
time you use the Mini DB accessory. 
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o Card.Deck 

• File Card Print 

.,Product I DESKPAK Desk Accmorie~ I 
Company I Simple Software Sys, Int. I 
Street 111612 Morth Landing Driv. 

City. St I Harietta. Georgia 
Zip 130066 
Phone 1(11011) 928-11388 

Desc. I I16S Mew Desk Accesories 

I¢I I¢I 

Figure 14. Mini DB: The mini-database. 

You may make any card deck the ~efault by saving it as 'CARD. DECK' on your 
boot disk in the 'DESKPAK' folder. You are responsible for creating the 
'DESKPAK' folder (if one doesn't exist) and saving the card deck in this folder 
under the name 'CARD. DECK'. See 'Save •• .' below for a description on how to 
do this. 

If Mini DB opens and does not find 'CARD. DECK', it acts as if you were starting a 
new card file named 'Untitled' having standard field labels. 

Using Mini DB 

Figure 14 shows the Mini DB desk accessory.The title bar shows the name of 
the current card deck you are working with. If you start a new card deck or open 
Mini DB and it doesn't find a default card deck, the title bar will show 'Untitled' 
and the fields on the card will be labeled 'Field l' through 'Field 7'. 

46 



DESKPAK DESK ACCESSORIES 

'* Menu 

Selecting the. menu from the Mini DB menu bar will display two menu items -
About ••• and Info •••. 

About ... 

About... displays the copyright, authors names, and other information. 

Info ... 

Information about the current card deck, such as the number of active cards, the 
amount of memory each card takes up, and whether there have been any . 
changes made to the card deck or not, appears under the Info ••• item. 

File Menu 

The File menu is where you can Get and Save card decks that you have 
created. You can also start a New card deck. 

New 

You can start an empty card deck without cards with New. If you made changes 
to the current deck, you will be asked if you wish to save it to disk before starting a 
new· deck. Choose Yes to save the deck, or No if you wish to discard any 
changes made. If you change your mind and don't want to start a new deck, 
choose Cancel. 

If you had cards in the active deck, you will also be asked if you wish to copy the 
currently existing cards into the new card deck. Choose Yes to keep the cards or 
No if you want to start the new deck with no cards. 

The title bar will change to 'Untitled', indicating this is a new card deck. 
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Get ... 

Get ... or '0 G' gets a card deck from any disk. If you made changes to the 
current card deck, you will be asked if you wish to save them. Chose Yes to bring 
up the 'Save File' window, No to discard the changes made to the current card 
deck, or Cancel if you change your mind about getting a card deck. A 
description of the 'Save File' window can be found in the Save .•• description 
below. 

Next, a 'Get File' window will appear which allows you to search through different 
disks and choose a card deck. Only files created with Mini DB will be displayed 
and selectable. To get a card deck or open a folder, double-click on the file name, 
or select the file and click in the Open button or press Return. Change disks 
by clicking on the Disk button, or pressing the Tab key. Close a folder by 
clicking on the Close button or pressing Esc. If you change your mind about 
getting a new card deck, click on the Cancel button or press '0.'. 

Save ... 

Save .•• or '0 S' saves the current card deck to disk. A 'Save File' window will 
appear, allowing you to specify the name of the file and what disk to save it to. 
Usually, you will save the file with the name given in the Save Card Deck As: 
box. 

Change disks by clicking on the Disk button, or pressing the Tab key. New 
folders are created by typing in a name for the folder in the Save Card Deck 
As: box and clicking on the New Folder button. To save the card deck with the 
name specified in the Save Card Deck As: box, click on the Save button or 
press the Return key. Change the name of the card deck with the Save Card 
Deck As: box. Close a folder by clicking on the Close button or pressing Esc. 
If you change your mind about saving a card deck, click on the Cancel button or 
press '0.'. 
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Make sure to change the name of an 'Untitled' card deck. If you save a card deck 
to a different name than the one specified in the title bar of the accessory, the title 
bar will change to reflect the new name. 

Creating a Default Mini DB File 

1 . Create the card deck you want as the default deck. 

2. Pull down the File menu and choose Save •.•. 

3. If the 'Save File' window appears with a folder icon above the list of 
filenames, click on the folder icon until it turns into a disk icon. 

4. Use the scroll bar to locate the 'SYSTEM' folder. If there is no 'SYSTEM'. 
folder, you cannot install a default card deck on the disk. 

5. Open the 'SYSTEM' folder. 

6. Enter 'DESKPAK' in the Save Card Deck As: box and click the New 
Folder button. A folder named 'DESKPAK' will be created. 

7. Enter 'CARD.DECK' in the Save card Deck As: box and Save the card 
deck. 

Card Menu 

The Card menu contains items for creating, finding, sorting, or deleting cards. 

New Card 

Add a new card to the current deck with New Card. The new card will be 
displayed and you can start typing information into the fields. You can move from 
one field to another by clicking in the box surrounding the field you wish to enter 
text in, or pressing the Tab or Return keys. 
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Full editing functions are supported in each field. If you are creating a card deck 
of names and addresses, you might want to put the last name first, so the 
person's name will be put in alphabetical order, just like a RolodexTM card file. 

Order Deck 

Cards can be alphabetically ordered on any field! For example, suppose you 
have created a card deck that is composed of the fields: Name, Address, City, 
State, Zip, Phone and Misc. If you want to sort the card deck by zip codes, click 
on the Zip field to make it the currently active field, and then select Order Deck 
or the keyboard equivalent 'Ls 0'. 

Edit Field ... 

Field names can be changed to whatever labels you want for the active card deck. 
For instance, to change 'Field.1' to read 'Name', click on ·'Field.1' and select Edit 
Field ... or 'Ls E'. Then type 'Name' in the edit box and press Return. 

Find .•. 

Use Find ..• ('Ls F') to search for some specific text in the current card deck. A 
window will appear allowing you to type in the text to be searched for. Find ••• will 
quickly search through all the cards and display either the first card containing the 
text or a message that the text could not be found. 

You should note three things regarding card searches: 

a.) the search begins at the first card in the deck 

b.) the search is done on the currently active field 

c.). the search is case insensitive. By doing a case insensitive search, the 
following text is found when specifying a search parameter of 'MINI': MINI 
Mini mini mini minit MiniDB. 
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Find Again 

You can find the next occurrence of the text searched for with Find ••. with Find 
Again or '0 A'. Another search for the text will be done from the current position 
in the card deck. 

Delete 

You can delete the currently displayed card by selecting Delete from the menu, 
or by pressing '0 0'. You will not be asked to verify the deletion. You can not 
recover the card once it has been deleted. If you just wish to clear the text from 
the fields of the card, select Clear from the program's Edit menu. 

Delete All ..• 

All of the cards can be deleted from the current card file. This operation is similar 
to the New item in the File menu, but it doesn't change the name of the current 
card deck to 'Untitled'. You will be asked to verify the operation. Click in the Ok 
button to continue or the Cancel button to cancel the operation. 

Be absolutely sure you want to delete all the cards from the deck. After the 
operation is verified, you can not recover the deck. 

Print Menu 

One very useful feature of Mini DB is the ability to print cards from the desk 
accessory itself. Cards are printed in text mode for the fastest printout possible. 
Printing starts at the current print head position on your printer. 
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Print 

Select Print or '0 P' to print the currently displayed card. 

Print All... 

This item will print all the cards in the card deck with your choice of formatting. You 
can specify which fields to print, the number of blank lines between each card, 
and whether you wish the field labels to be printed with the text of the field. The 
window will display the field labels in the area titled 'Print Fields'. Select the fields 
to print by checking the 'check boxes'. Disable the text from being printed for any 
field by unchecking the box. 

Th.e last box in the 'Print Fields' area titled 'With Labels' allows you to specify 
whether you want the field labels printed too. Check the box if you wish the field 
labels to be printed. 

The push buttons in the 'Space Between Cards' area are used to select the 
number of blank lines to print between each card (1-5 lines). 

When you have made your selections, click in the Ok button to begin printing or 
the Cancel button if you change your mind about printing the card deck. Cancel 
the printing in progress by clicking the mouse button. 

For example, the following illustrates a card printed from a deck containing Apple 
IIGS product information. All 7 fields were printed with labels. 
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Closing Mini DB 

When you are finished using Mini DB, click in the 'Close Box'. If you made any 
changes, you will be given an opportunity to save them. 

Tips 

The text files created by Mini DB can be read by most database programs. 

If you need several different card decks with the same field labels, create an 
empty deck with the labels you use most often and save it to disk. This 
blank deck can be used as a template for creating future card decks. 

• It is always a good idea to Save the current card deck periodically while you 
are entering cards. That way, if something should occur (like a power 
outage) you won't have to re-enter everything. 

Keep all the card decks in one folder. This will enable you to quickly find 
any card deck and is good disk management. A good place to keep your 
decks is in the 'DESKPAK' folder on your boot disk. 

If you want to change the default card deck, open the 'CARD. DECK' file 
and save it with a different name, then open the card deck you want as the 
new default file and save it as 'CARD.DECK' in the 'DESKPAK' folder -
replacing the current one. You can also use File Tools to rename the 
card decks. 

The • menu on the Mini DB menu bar does not contain desk accessories. 
Desk accessories are only available under the program's colored. menu. 

Make sure you back-up your Mini DB files just as you would any other 
important data. 
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Chapter 12. Notepad 

Notepad is a convenient place to keep notes, addresses, phone numbers or 
the outline to your latest novel. You can keep 25 pages of notes on each 
Notepad file and print each page individually or the entire file together. 
Notepad supports mouse selection of text as well as arrow key cursor 
movement andtext selection. Notepad also allows cutting and pasting of text. 

Default Notepad 

When Notepad is used, it looks for the 'Notepad.txt' file in the 'DESKPAK' folder 
on the boot disk. If it does not find this file, Notepad opens a default file titled 
'Untitled'. You are responsible for creating the 'DESKPAK' folder and saving the 
default notepad as 'Notepad.txt'. The procedure for doing this is outlined in the 
SAVE... menu item description. 

Using Notepad 
When Notepad opens, the title bar will be set to 'Notepad.txt' or 'Untitled', 
depending on if the default file was located or not. 

Text Entry 

To begin adding text, just start typing! Notepad works just like most word 
processors. Move the cursor with the arrow keys or position it with the mouse. 
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CI Hotepad.Txt 
, File Page Print 
a Pick up groceries for dinner. 
o Call Hike and get source code 

for next product she II. 
o Don't forget 8011 with Dove S. 
o Call Hike W. about concot bug. 

~ 1 

Figure 15. The Notepad: Turn pages by clicking in the bottom 'dog-ears'. 

Editing 

left arrow key: 

1) alone - move left 1 character 
2) &a - move left 1 word 

3) &a - move to start of line 
4) & shift - select left 1 character 
5) & shift-a - select left 1 word 
6) & shift-a - select to start of line 

right arrow key: 

1) alone - move right 1 character 
2) &a - move right 1 word 
3) & a - move to end of line 
4) & shift - select right 1 character 
5) & shift-a - select right 1 word 
6) & shift-a - select to end of line 
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down arrow key: 

1) alone 
2) &. 
3) & shlft-. 

up arrow key: 
1) alone 
2) &. 
3) & shlft-. 

- move down 1 line 
- move to end of page 
- select to end of page 

- move up 1 line 
- move to top of page 
- select to top of page 

control F - delete selection or character to right of cursor 
control X - delete selection or line 
control Y - delete selection or to end of line 
Del et e - delete selection or character to left of cursor 

You may also select text by clicking and dragging through the text with the 
mouse. The mouse selection can be extended by holding down the shift key. 
while clicking and dragging. The keyboard and mouse can be interchanged while 
making a selection. 

Edit items on the menu bar also operate on a selection. Clear will clear-out the 
selected text, Copy or '0 C' will put a copy of the text on the 'Clipboard' leaving 
the originally selected text intact, and Cut or '0 X' will place the text on the 
'Clipboard' and remove the originally selected text. You may also choose Paste 
or '0 V' to move text from the 'Clipboard' to the notepad. 

Changing Pages 

Clicking in the upper triangle of the 'dog-eared' page will flip to the next page of 
the Notepad while clicking in the bottom triangle will flip to the previous page. 
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• Menu 

About ... 

The About .•• item displays a window containing the copyright information, 
version number, and other information about this accessory. You can also select 
this item using the keyboard equivalents '0 ?' or '0 I'. 

File Menu 

The File menu in Notepad's menu bar provides access to file handling 
functions like New, Get ••• and Save ••.. 

New 

New is used to start an empty notepad file. If you made changes to the current 
notepad file, you will be asked if you wish to save it to disk. A description of the 
'Save File' window can be found below in the Save... menu item section. 
Notepad's title bar will change to 'Untitled', indicating a new notepad file. 

Get ..• 

Get ... or '0 G' is used to get a notepad from any disk. If you made changes to 
the current notepad, you will be asked if you wish to save it to disk. Click in the 
Ok button to bring up a 'Save File' window, or Cancel to discard the changes. 
made to the current notepad file. A description of the 'Save File' window can be 
found below in the Save •.• menu item. A 'Get File' window will appear, allowing 
you to search through different disks to find a notepad file. Any 'Text' files will be 
displayed and selectable. To select a notepad file or open a folder, double-click 
on the file name or select the file and click in the Open button or press Return. 
The Disk button or Tab key changes disks. Cancel will abort the operation. 
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Save ... 

You can keep the notepad file on any disk with Save •.• or '0 S'. A 'Save File' 
window will appear in which you may specify the name for the file. Usually, you will 
save the file with the name given in the Save Notepad As: box. To change 
disks, click in the Disk button. Folders can be created by typing a name for the 
new folder in the Save Notepad As: box and clicking on New Folder. To 
open a folder, double-click on the folder name or select the folder and click in the 
Open button. Close or ESC will close the folder. 

Enter a name for the file in the Save Notepad As: box and click on Save. If 
you change your mind about saving the notepad file, select Cancel or '0:. If 
you save a notepad to a different name than the one specified in the Save 
Notepad As: box, it will change to reflect the new name. 

Note: As explained in Default Notepad above, there is a way to have 
Notepad look for and load a default notepad from the boot disk each time it is 
opened. The steps to create this default file are: 

1 . Create the notepad you want as the default notepad file. 

2. Pull down the File menu and choose Save •••. 

3. Use the scroll bar to the right of the list of filenames to locate the 'SYSTEM' 
folder. 

4. Open the 'SYSTEM' folder. 

5. If the 'DESKPAK' folder exists, open it. Otherwise enter 'DESKPAK' in the 
Save Notepad As: box and click in the New Folder button. A folder 
named 'DESKPAK' will be created. Open this folder. 

6. Enter 'Notepad.Txt' in the Save Notepad As: box and click in the Save 
button or press Return. 
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Notes Menu 

Jump To ... 

Jump To .•. or '0 J' allows you to enter a page number to 'jump to'. Type the 
page number to jump to in the window that opens. Click in the Ok button to go to 
the page, or Cancel to abort the operation. You can also call up the Jump To 

. window by clicking on the current page number at the bottom of the notepad. 

Delete 

The Delete menu item (or '0 D') will delete the currently displayed page. You 
will not be asked to verify the deletion. Once the page is deleted you cannot 
recover it. You might want to consider using Cut ('0 X') from the Edit menu as 
you can always Paste the text back if you made an error. 

Delete All... 

Delete All .•• will completely erase a" of the pages in the notepad. 8 e 
absolutely certain that you want to delete the notepad. Once the operation has 
been verified, you can not recover the deleted pages. 

Print Menu 

The Print menu gives access to the printing routines. 

Print Page 

Select Print Page or '0 P'to print the current page. If there is no text on the 
page, nothing will be printed. 
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Print All 

This option will print all of the pages in the notepad. 

Tips 

It is a good idea to Save ('O S') the current notepad file periodically. That 
way, if something should occur (like a power outage) you won't have to re­
type everything. 

If you have lots of notepads, keep them in one place to make finding them 
easier. Try setting-up a separate disk of notepads, or a folder called 
'NOTEPADS'. 

Notepad saves its notepad files as text files. If you attempt to read in a file 
. that is not a Notepad file, the results will be unpredictable. 

• The • menu on Notepad's private menu bar will not contain desk 
accessories. Desk accessories are found under the program's colored '* 
menu. 

• Make sure you back-up your Notepad files just as you would any other 
important data. 
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Chapter 13. Password 

Password is a full-featured security locking system for your Apple IIGS. 
Password will lock intruders out and keep others from interfering with sensitive 
data you may be working on. Password also allows you to install a 'logon' 
system requiring password entry before permitting your disks to boot (especially 
useful on hard drives). You may install the disk password protection to any 
number of disks at one time. 

Using Password 

Password Entry 

When opened, Password will ask for a 1 to 20 character password. All editing 
functions are available, although cut, copy and paste are inactive (to further 
protect the system). . 

Make sure to remember your password! Once the system is locked, it will 
remain so until the correct password is entered. If you lock-up your system and 
forget your password, you will have to re-start the computer, losing anything you 
were working on! 

System Lock 

After typing in an appropriate password, clicking on the Ok button or pressing 
Return will clear the screen to black and lock-up the system. If you do not wish 
to lock-up the system you may select the Cancel button. While the system is 
locked, the border will flash every 15 seconds, letting others know the computer 
is still in use. 
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System Unlock 

Pressing the mouse button or a key on the keyboard will re-display the 
Password window. Type in the password you used to lock the system with and 
click on the Ok button or press Return. The original screen will be displayed 
and the system will be freed for further use. If you change your mind about 
unlocking the system, click in the Cancel button. If you do nothing within 30 
seconds, Password will revert to its locked state. 

Disk Protect 

You may also lock the disk with Password's Protect Disk feature. Select 
Lock to lock the currently displayed disk (after entering a password), Cancel to 
abort the disk lock or Go to Next Disk to continue searching for other disks to 
lock. 
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Set the Password: 

I DESKPAKI 

c:EJ (Concel) 

( Protect Disk ) 

Copyright (c) 1988 SSSI. Inc. 

Figure 16. Disk Lock Password let's you lock any disk. 
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If the disk you lock has already been locked, you will be required to enter the 
original password that the disk was locked with before proceeding. After doing 
so, you will be given the choice of replacing the password, removing the disk's 
old password protection, or canceling the operation. 

Again, make sure to remember your password! Once the disk is locked, it will 
remain so until the correct password is entered. If you lock up your disk and 
forget your password, we can recover it (only if you've sent in your registration 
card). 

The" Key 

When you open Password from the. menu, you may hold down the. key on 
the keyboard to deactivate the border flash feature. 

Background Functions 

Password was designed to continue background functions, such as printing, 
while it is active. This is a convenient feature to use to protect the system while 
you are printing a large document. 

Forgotten Passwords 

If you forget your password while the system is locked up, you will have to re-boot 
the computer, losing whatever you were working on before you locked the 
system. 

If you lock a disk and can't remember the password you will not be able to re-boot 
with that disk. You can still boot with an unlocked system disk and access the 
information from the locked disk. We can remove the lock, but only for registered 
users. 

• Remember your password!!! 
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Chapter 14. Print It 

Print It is used to print a text file on your printer. It formats the text and places 
the page number and time and date as a header on each page. 

Using Print It 

When Print It opens, a file selection window, similar to File Tools file selection' 
window, is displayed. Only folders and files that can be printed are displayed. 

Make sure your Imagewriter II is turned-on and the paper is set to its correct 
position (the top of the sheet of paper or the perforation on form feed paper 
should be lined up with the red horizontal line on the plastic platen cover) before 
selecting the file to print. The file you chose will be loaded and sent to the printer 
with a heading on each page that includes the page number, filename and 
current time and date. While the file is being printed, a message will appear on 
the screen. Press the mouse button to halt printing. 

Note that if the Select button on the Imagewriter is Off, Print It will wait until 
you put the printer on-line (Select button On). If the Imagewriter is off, Print It 
will perform as if it were printing the file, but nothing will happen. 
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Print It (e) 1987,88 SSSI - Vm 1.0 

..es:./Sslsre.s~;liii~tdemo/ 
•• "!IoIIi.I.I:JIII •• , ( Disk 
[) Animdelllo.Haeros 

) 

« Choose) 

( Close ) 

Iu ( Quit ) 

Figure 17. Print It. 
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Chapter 15. Puzzle 

The Puzzle is a simple game to pass away time. The object of the game is to put 
the letters (A to S) or numbers (1-19) in order. 

Using the Puzzle 

When you select Puzzle from the. menu, its window will appear. The positions· 
of the letters or numbers will be different each time you use the accessory. 

To organize the tiles, just click on a tile next to the open area. The tile clicked on 
will move into the open area. The game can be played with numbers rather than 
letters, to switch from one to the other, click on the open area. You may, at any 
time, click in the 'Close Box' to end the game or select another window on the 
screen to deactivate Puzzle. Continue organizing tiles until you have them in 
order from A to S (or 1 to 19). Puzzle will reward your 'win' by flashing the menu 
bar and beeping! To play again, click anywhere in the Puzzle's window. 

'0 ?' or '0 I' displays the copyright information for Puzzle. 
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K G S P F 

Figure 18. Puzzle. 
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Chapter 16. Screen Saver 

DESKPAK's Screen Saver desk accessory allows you to save any 320 or 640 
mode graphics screen to disk. The only requirement is that the application 
supports NDAs. Unlike other screen saving desk accessories, Screen Saver 
allows you to specify the disk and folder that the screen will be saved to, and the 
filename of the saved screen. You can then modify or print the screen with any of 
the popular graphics programs for the IIGS. 

Using Screen Saver 

When you open Screen Saver, you will be presented with a standard 'Save 
Rle' window which allows you to specify the filename, folder and disk that the 
screen image will be saved to. 

You may create a new folder by typing in a name for the folder in the Save 
Screen As: box and clicking on the New Folder button. To open a folder, 
double-click on the folder name, or select the folder and click in the Open 
button. To save the screen with the name specified in the Save Screen As: 
box, click in the Save button or press the Return key If you change your mind 
about saving the screen, click in the Cancel button or press the Esc key. 

After choosing the filename, click in the Save button and the Screen Saver 
window will close. Approximately 10 seconds later, you will hear a double beep. 
The current screen will be saved to the chosen disk under the chosen filename 
and the speaker will emit a double beep again, indicating a successful save. 
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Figure 19. Screen Saver. 
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Chapter 17. Start Up 

Note: Start Up is not a desk accessory, and should not be installed in the 
'DESK.ACCS' folder. 

Start Up is a start-up program designed to display a picture on the Apple IIGS 
screen at boot time. Any graphic file created with popular graphics programs like 
816 PaintTM, Deluxe Paint IITM, PaintWorks Plus™, PaintWorks Gold™ can be 
used as your start-up screen. 

Using Start Up 

Start Up is automatically run at boot time, but you will have to install it and the 
picture you want displayed. 

Start Up Installation 

Since Start Up is a program, not a New Desk Accessory, you will have to copy it 
from the DESKPAK disk's 'SYSTEM.SETUP' folder (located in the 'SYSTEM' 
folder) to the 'SYSTEM.SETUP' folder on your boot disk. You can use File 
Tools or the Finder to copy Start Up to your boot disk(s). 

Picture Installation 

Start Up will only display unpacked pictures (filetype $C1), such as those 
created by the DESKPAKScreen Saver. If you have a program that displays 
filetypes, the correct picture filetype is $C1. 
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Copy the picture you wish to be displayed to your disk's 'SYSTEM.SETUP' folder 
(located in the 'SYSTEM' folder) and name it 'STARTUP.PIC'. You can use File 
Tools or the Finder to copy and rename the picture file. 

Booting 

With Start Up installed, the picture named 'STARTUP. PIC' will be displayed 
during the boot process. 

Tips 

To take the Start Up graphic off a disk, erase the file 'STARTUP.PIC' from 
the 'SYSTEM.SETUP' folder found in the 'SYSTEM' folder. 

• If you are booting your computer into a text screen environment (like 
Appleworks 2.0), rather than a graphics environment (Ii~e the Finder), you 
will not be able to get back to the text screen. It is best not to use Start Up 
in this case. 
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Chapter 18. Simple Scrap 

The ability to 'cut and paste' information (text, graphics, etc.) is a very powerful, 
and often overlooked, feature of the Apple IIGS system. Any information that is 
transferred from one place (or program) to another is first placed in a special area 
of memory called the 'Clipboard' (you can look at this Clipboard with Clipboard). 
Unfortunately, only one piece of information can occupy the Clipboard at a time, a 
very serious limitation. One solution to the problem is to keep a collection of 
Clipboards in a 'scrapbook'. 

Simple Scrap is an NDA scrapbook that allows you to save text or graphics 
'scraps' together in a scrapbook file. As an added enhancement, Simple Scrap 
also allows you to have an unlimited number of different scrapbook files (not so 
simple after all!). In addition to the convenience of keeping scrapbooks with their 
associated programs (in the same folder or disk), this feature provides for a 
limitless number of scrapbooks. 

Simple Scrap also lets you do some editing of the scrap before you paste it into 
your document. For instance, you can select just a portion of the text or picture 
scrap to be copied onto the Clipboard. Each individual scrap in the scrapbook 
can have its own name, and you can have any number of scrapbooks on any 
number of disks saved with any name you like. 

Default Scrapbook 

When Simple Scrap is opened, it looks for a file named 'SCRAP.BOOK' in the 
'DESKPAK' folder. If it does not find this file, it opens an empty scrapbook. If the 
'SCRAP.BOOK' file is found, it is loaded and displayed. This file is called the 
default file, and it allows you to have a standard scrapbook on your disk which will 
open every time you open the accessory. 
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Figure 20. Simple Scrap. 

If you have a scrapbook that was created with Simple Scrap or Super Scrap 
(see next chapter) that you wish to be opened whenever you run the scrapbook, 
save it using the name 'SCRAP.BOOK' in the 'OESKPAK' folder. 

When Simple Scrap opens the title bar will be set to either 'Untitled' or 
'Scrap. Book' - the default file. 

Using Simple Scrap 

Title Bar 

Simple Scrap's title bar of displays the name of the current scrapbook file you 
are working with. If you start a new scrapbook or open Simple Scrap and it 
doesn't find a default scrapbook, the title bar will be display 'Untitled'. 
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Scrap Name 

The lined area above the scrap area shows the name of the currently displayed 
scrap. When a scrap is first created or pasted into the scrapbook, a default name 
is used: the first scrap is called Scrap 1, the second Scrap 2, and so on. You may 
change the name of a scrap at any time, and duplicate names are permitted. 

Scrap Area 

Below the menu bar is a large rectangular area called the scrap area. This is where 
the scraps are displayed and where you select portions of an image to be Cut or 
Copied onto the Clipboard. 

The scrap area is fixed, that is, it can only display a certain size scrap. For 
example, if you try to paste a picture as big as the screen into the scrapbook, the 
image will be centered and the picture will be clipped to the scrap area. All of the 
text pasted into the scrapbook will be maintained, although only a portion of it will 
be displayed. 

Pasting large images and lots of text into the Scrapbook, when only small pieces 
are needed, wastes memory and disk space. Remember, this accessory is a 
Scrapbook, not a word processor or paint program. 

Selection Tool 

Clicking and dragging the mouse in the scrap area creates an 'editing box'. 
Anything enclosed in the selected rectangular area will be cut or copied to the 
clipboard using the appropriate Edit menu command. Use this feature to copy 
(or cut) a piece of the Original scrap to paste into your program. 

Note that text in the scrapbook would be copied to the Clipboard as a picture if 
part of the text was selected using the Selection Tool. 
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Cut and Paste 

Simple Scrap relies almost entirely on the Edit menu options found on most 
menu bars. To add a picture or text to the scrapbook, you must first have 
something on the Clipboard. Usually, you will select a portion of a picture or text, 
and select Copy ('0 C') or Cut ('0 X') from the program's menu bar. The 
selected image or text will be put on the Clipboard. Then, to put what is on the 
Clipboard into the scrapbook, open Simple Scrap and select Paste ('0 V') 
from the program's menu bar. The picture or text will be pasted into the 
scrapbook as a new scrap. 

Note: If you wish to see what is on the Clipboard at any time, you may use the 
Clipboard desk accessory, described in Chapter 8. 

To take a scrap from the scrapbook and put it onto the Clipboard. select the 
desired scrap by pressing the right arrow (next scrap) or left arrow (previous 
scrap). Cut will remove the current scrap from the scrapbook and place it on the 
Clipboard. Copy will move a copy of the current scrap to the Clipboard, leaving 
the original scrap in the scrapbook. If you have selected a portion of the 
displayed scrap, only that portion will be transferred to the Clipboard. Then close 
Simple Scrap or click in the window you wish to Paste the scrap to, and select 
Paste from the Edit menu. 

You can also choose Clear from the Edit menu to delete the current scrap from 
the scrapbook without copying it to the Clipboard. 

Ii Menu 

About ... 

About ••• displays the copyright and authors names. 
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Info ... 

Information about the current scrapbook, such as the number of scraps, whether 
changes have been made to the scrapbook, whether the scrap currently 
displayed is of text type or picture type or how much memory the current scrap 
takes-up, can be obtained from Info •••. 

File Menu 

The File menu provides access to Get and Save scrapbooks that you have 
created. 

Get ••• 

Get ••• or '0 G' gets a scrapbook from any disk. If you made changes to the 
current scrapbook, you will be asked if you wish to save them. Choose Yes to 
bring up the 'Save File' window, No to discard the changes made to the 
scrapbook, or Cancel if you change· your mind about getting a scrapbook. A 
description of the 'Save File' window can be found in the Save ••• description 
below. 

Next, a 'Get File' window will appear which allows you to search through different 
disks and choose a scrapbook. Only files created with Simple Scrap or Super 
Scrap (next chapter) will be displayed and selectable. To select a scrapbook or 
open a folder, double-click on the filename, click in the Open button or press 
Return. Change disks by clicking on the Disk button, or pressing the Tab key. 
Close a folder by clicking on the Close button or pressing Esc. If you change 
your mind about getting a new scrapbook, click on the Cancel button or press 
'a .'. 

Save .•. 

Save ••• or 'a S' saves the current scrapbook to disk. A 'Save File' window will 
appear, allowing you to specify the name of the file and what disk to save it to. 
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Change disks by clicking on the Disk button, or pressing the Tab key. New 
folders are created by typing in a name for the folder in the Save Scrapbook 
As: box and clicking on the New Folder button. To save the scrapbook with 
the name specified in the Save Scrapbook As: box, click on the Save button 
or press the Return key. Change the name of the scrapbook with the Save 
Scrapbook As: box. Close a folder by clicking on the Close button or 
pressing Esc. If you change your mind about saving a scrapbook, click on the 
Cancel button or press '0.'. 

Make sure to change the name of an 'Untitled' scrapbook. If you save a 
scrapbook to a different name than the one specified in the title bar of the 
accessory, the title bar will change to reflect the new name. 

Note: As explained in Default Scrapbooks above, there is a way to have 
Simple Scrap look for and load a default scrapbook file from the boot disk each 
time it is opened. The steps to create this default file are: 

1 . Create the scrapbook you want as the default scrapbook file. 

2. Pull down the File menu and choose Save •••. 

3. Use the scroll bar to the right of the list of filenames to locate the 'SYSTEM' 
folder. 

4. Open the 'SYSTEM' folder. 

5. If the 'OESKPAK' folder exists, open it. Otherwise enter 'OESKPAK' in the 
Save Scrapbook As: box and click in the New Folder button. A folder 
named 'OESKPAK' will be created. Open this folder. 

6. Enter 'SCRAP. BOOK' in the Save Scrapbook As: box and click in the 
Save button or press Return. 
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Scraps Menu 

Select the Scraps menu when you wish to delete or rename the currently 
displayed scrap. 

Rename •.. 

You can rename the current scrap by choosing Rename .•• or using the 
keyboard equivalent '0 R'. A window will be displayed showing you the current 
scrap name, and a place for you to type in the new scrap name. Type in the new 
scrap name and click in Ok to change the name or Cancel to abort the name 
changing operation. The scrap title will change to the new name. 

Delete 

Delete or '0 0' deletes the currently displayed scrap. This command is the 
equivalent of selecting Clear from the program's Edit menu. 

You will not be asked to verify the deletion. You can not recover the scrap after 
this operation. Once the scrap is deleted, it is gone forever. 

Closing Simple Scrap 

When you are finished using the scrapbook, click in the 'Close Box'. If you made 
any changes, you will be given an opportunity to save them. 
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Tips 

Remember that Simple Scrap is intended to give you easy access to text 
and graphics scraps that you use often. Don't keep scraps in the 
scrapbook unless you use them, as they take-up disk space and, more 
importantly, memory space. 

• Try naming your scrapbooks with '.Scrap' appended to the filename, as in 
'My. Scrap' or 'Bobs.Scrap'. That way, you will always know the file is a 
scrapbook file. 
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To keep scraps orderly and easy to find, you might consider creating 
several different scrapbooks for various activities. For example, you might 
have a scrapbook called 'Business.Scrap' containing letterhead and logos 
for your company, and 'Per.Scrap' for your personal correspondence, both 
saved in the 'DOCUMENTS' folder with your word processing program. 

It is a good idea to Save the current scrapbook periodically. If something 
should occur (like a power outage) your scraps will be saved to disk. 

You can keep all of your scrapbooks in one folder or on one disk to make 
them easier to find quickly. 

The '* menu on the Simple Scrap menu bar does not contain desk 
accessories. Desk accessories are available under the program's colored '* menu. 

Simple Scrap's colors match the color palette the current program is 
using. If you change a palette within the program, the scrapbook will reflect 
the color change immediately. 
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Chapter 19. Super Scrap 

Super Scrap operates in the much same manner as Simple Scrap (described 
in the previous chapter). Please read about Simple Scrap first because scrap 
handling is identical in Super Scrap and will not be covered again in this 
chapter. Simple Scrap was designed for users with small memory 
configurations (512K) to access a 'traditional' scrapbook (with some powerful 
added features!) without causing problems with their programs. Super Scrap 
moves the scrapbook into a new generation. Super Scrap's drawing tools will, 
look familiar to users of Apple I/GS 'paint' software. With these tools, you can edit 
an existing scrap or create a new scrap from scratch, all within Super Scrap. 

Super Scrap also allows you to search through the scrapbook by name. You 
can delete an individual scrap or the entire scrapbook, or 'map' parts of a scrap to 
the window or selection rectangle. Super Scrap supports the undo feature, 
as long as you do not do anything else. 

USing Super Scrap 

Both Super Scrap and Simple Scrap use the same file format, and files 
created with one scrapbook are compatible with the other. In fact, both Super 
Scrap and Simple Scrap use the same default file. See the section on 
Default Scrapbook in chapter 18 to learn how default scrapbooks work. 
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o ScroP.Book 
Extras 

Figure 21. Super Scrap: The next generation of scrapbooks. 

File Menu 

The File menu has one additional feature not supported in Simple Scrap. 

New 

With New, you can start an empty scrapbook without any scraps. If you made 
changes to the current scrapbook, you will be asked if you wish to save them. 
Choose Ok to save the scrapbook, or Cancel if you wish to discard any changes 
made. If you decide to save the scrapbook, you will be presented with the 'Save 
'File' window, a description of which can be found in Simple Scrap's Save 
item. The new scrapbook will be named 'Untitled'. 

Scrap Menu 

In addition to the Rename and Delete functions of Simple Scrap, many new 
functions have been added. 
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Find ..• 

Use Find ••• ('0 F') to search for a specific scrap by name in the current 
scrapbook. A window allowing you to type in the name of the scrap to search for 
will appear. Find will quickly search through all the scraps in the current 
scrapbook, displaying the scrap when found or displaying a message that the 
scrap could not be found. 

Three notes regarding scrap searches: 

a.) The search begins at the first scrap in the scrapbook. 

b.) The search is case insensitive. 

c.) The search will return a scrap whose name contains the search name, ie. a . 
search parameter of 'SCR' will return Scrap 1 , scrap, Bosscraw or SCRAPE. 

Find Again 

You can continue the search started with Find ••• with Find Again ('0 A'). The 
continued search will be done from the current position in the scrapbook. 

Delete All 

All scraps in the current scrapbook can be deleted quickly using Delete All. It is 
quite similar to New in the File menu, although it doesn't change the name of 
the current scrapbook. You will be asked to verify this action. Click in the Ok 
button to proceed, or the Cancel button to cancel the operation. 

Be absolutely sure you want to delete the scrapbook. Once verified and 
deleted, the scrapbook can not be recovered. 
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Extras Menu 

The Extras menu is only found in Super Scrap and allows you to select an 
area on the displayed scrap and erase it, re-size it to the scrap area, or re-size the 
scrap area to the selection. 

Erase Selection 

Selecting this item will erase the area selected on the scrap. 

Fit To Window 

Fit To Window will re-size the selected part of the scrap image to fit the entire 
scrap area. The rest of the scrap image is lost. 

Fit To Selection 

Choosing this item will re-size the entire scrap area into the selection rectangle. 

Tools 

To the left of the scrap area are 8 tools, all of which operate on scraps appearing in 
the scrap area. To select ~ tool, simply click on its icon, which will become 
highlighted. 

Selection Tool 

The selection tool operates just like the selection tool in Simple Scrap. Click 
on the selection tool, and select the part of the currently displayed scrap you wish 
to Cut or Copy to the 'Clipboard'. You may also select one of the options in the 
Extras menu. 
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Eraser Tool 

The eraser tool allows you to erase any portion of the scrap, and works just like a 
real eraser. Select the eraser tool, and move it over the scrap area. Press the 
mouse button to erase the drawing under the eraser cursor. Hold the button 
down to continuously erase. 

Freehand Drawing· Tool 

The freehand drawing tool works in the selected color and line width. 

line Tool 

The line tool allows you to draw lines using the currently selected color and line 
width. To draw lines, click on the line tool, and move the cursor over to the scrap 
area. Press the mouse button at one end of the line you wish to draw and hold it 
down. Now move the mouse (still holding down the button) to the other end of 
the line you wish to draw (within the scrap area) and release the button. A 
representation of the line follows the mouse, indicating where the line will be 
drawn when the mouse button is released. 

Rectangle and Filled Rectangle Tools 

The rectangle tool allows you to draw a rectangle anywhere within the scrap area. 
This tool operates just like the selection tool, except when the mouse button is 
released, the rectangle is drawn using the current color and Une size. 

The filled rectangle tool operates similarly, except when the mouse is released, 
the rectangle is filled using the current color. 
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Circle and Filled Circle Tools 

The circle and filled circle tools work just like the rectangle and filled rectangle 
tools, except that a circle (or oval, depending on how you draw it) is drawn using 
the current color setting. 

Line Width 

The line width area is located below the tool area, and allows you to select how 
wide lines will be. The../ mark shows the currently selected line width. The lines 
also show the currently selected color (discussed next). If you change to a new 
color, the lines change to the selected color. 

Color Selection 

The 16 colors below the line width selection area allow you to select which color 
you will use to draw lines, or fill circles and rectangles with. To select a color, click 
on the desired color, and the lines in the line width area will change to that color, 
indicating your selection. The color palette shown is based on the current 
program's color palette. If you change the current program's color palette, the 
scrapbook's color palette will change too. The color palette has 16 colors to 
choose from, no matter what mode you happen to be in. This works out well for 
programs that only have 4 colors in 640 mode, as you can create an image, copy it 
into the scrapbook, modify the image using the extended colors, copy the scrap 
back onto the 'Clipboard', and paste the new image into your program. 

Moving Between Scraps 

Use the right arrow (next scrap) or left arrow (previous scrap) to move from 
one scrap to another. 
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Chapter 20. Times 3 

Times 3 is a more than your average clock desk accessory. It has 3 clocks, one 
of which should suit most tastes. You can display the time in the menu bar of your 
programs, display a small clock with the time alone, or quickly display the clock 
with the time and date. 

2:10 PM 

o Times 3 
Hov 20, 1988 2:10 PM 

Menu Small 

Figure 22. Times 3: The multiple clock. 

Using Times 3 

Times 3 will show the current date and time. If the date or time are incorrect, you 
can change it using the Apple IIGS control panel. You need do nothing with this 
clock desk accessory. Times 3 provides quick access to the time and date, a 
function suitable for most of us. But others want something different. .. 
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The Menu Clock 

The Menu button installs a 'digital' clock in the upper right-hand corner of the 
menu bar. The menu clock will stay active even after you close Times 3. You 
can turn the menu clock off by clicking the Menu button again. If you close the 
accessory, you will have to re-open it to take the clock off the menu bar. 

The Menu Clock may over-write items on some programs with lengthy menu bars. 
Even so, you will still be able to operate those menu items if you click on the 
clock. The menu clock works properly in both 320 and 640 modes. 

Small Clock 

For those who find the menu bar clock distracting there is a small clock. Click the 
Small button to turn Times 3 into a tiny clock. You can then move the clock to 
an out-of-the-way space on the Desktop. When you are· through with the small 
clock, just click in the 'Close Box'. 

Program Switches 

An added feature of the menu clock is its ability to remain active between 
programs. Once set, the menu clock will remain on the menu bar until you select 
the Menu button again. You may, for instance, use the menu clock on the 
Finder. Selecting an Apple JIGS program from the Finder will launch that program. 
When the new program displays its menu bar, the menu clock will again be 
displayed. 
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Chapter 21. Everyday Examples 

Many uses of DESKPAKdesk accessories are obvious, like making a quick note 
to yourself in the Notepad, or keeping track of appointments with 
Appointments. However, the following few examples are provided to give 
you an idea on how you can combine one or more features of DESKPAKwith 
the work you do on your Apple IIGS. Ideas on how to use the accessories in new 
and different environments are left for you to discover. 

Calculator Example 

You are writing a letter to your stock broker to buy some stock from Company 'A' 
and you need to do few calculations to determine how much to buy. Open the 
Calculator and perform the calculation. Pull down the Edit menu from the 
program's menu bar and choose Cut ('0 X')or Copy ('0 C'). Now click in the 
program's window to make it the active window. Click at the place in the letter 
where you would like the calculation to appear. Pull down the Edit menu again 
and select Paste ('0 V'). The calculation will be placed in the body of your letter. 

Mini DB Example 

Your job is to keep track of incoming phone orders that will later be processed by 
the shipping department. Although it might be easier to just keep a database 
program up and running, you have other responsibilities, such as preparing 
invoices, that take up most of your time. It is impolite to ask the calling party to 
hold while you quit your word processor and boot your database. Writing down 
the information on paper and typing them into the database later is somewhat 
tedious, and besides, you got a computer to save you time. 
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Use the Mini DB accessory while in your word processor to keep track of the 
orders. Make sure you set-up the order entry card deck to be the default file, so 
when you open Mini DB, you'll be ready to go. When you're ready to add the 
orders to the database program, just select the option of reading a text file into 
the database. Most database programs will read text files. If not,You can use Cut 
and Paste from the Edit menu to place the data in your database. 

ASCII Chart Example 

You need to know the hexadecimal representation of an ASCII character. You left 
that book with ASCII values right next to your keyboard just 10 seconds ago, but it 
has grown legs and taken a walk. Open the ASCII Chart and look up the ASCII 
code, or type in the character you need from the keyboard. 

Or, you want to 'spruce up' a letter with an • symbol! You can use the ASCII 
Chart to find the proper keyboard sequence for the •. 

Password Example 

As the owner of a computer software store, you would really like to leave several 
programs running on your computer for demonstration purposes. The problem is 
that several untrained customers have come into the store and played with the 
program, deleting system files and other important files from the disk. 

Install Password on your demonstration disks. You can run the program, call up 
Password, and lock up the system until your password is re-entered. You can 
also password protect the disks themselves, which will require your password 
before booting. 

Notepad Example 

You are currently working on three projects. Being smarter than a computer, you 
have ideas regarding your other two projects while working on the first. Sure, you 
write them down, but they usually get lost in the paper shuffle between projects. 
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Open the Notepad, jot down your ideas, and return to what you were currently 
working on. Later, when you're working on the other project, call up the 
Notepad and review your ideas. Remember, you can have multiple note files on 
any disk, so you might want a separate notepad file for each project. 

Appointments Example 

You need to keep track of appointments for 25 different persons. Initialize a new 
data disk, and use Calendar to create 25 different Calendars, one for each 
individual. If you have already created the calendars, and just want them on one 
disk, call-up File Tools and copy them to the new disk. 
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Appendix A. General Information 

DESKPAK Disk 

This version of DESKPAK is shipped with the GS/OSTM System 4.0 (Apple's 
new true 16 bit operating system specifically for the I/GS). Some of the files 
found on the complete System Disk had to be taken off to allow room for the· 
DESKPAK accessories. The files removed were the AppleTalk support drivers, 
'Basic System', and device drivers. 

If you need any of these files and don't have a copy of the 4.0 System Disk, your 
Apple Dealer will be glad to give you one for free if you bring in your original 
System Disk. 

Minimum System Requirements 

Apple JIGS (512K). Note that the DESKPAK desk accessories do not 
need 512K, but the Finder shipped with DESKPAK does. 

One 31/2" disk drive. 

2.0 ROM upgrade - you will see a 'v01' at the bottom of the start screen 
when booting (available as a free upgrade from your Apple dealer). 

• ProDOS and Loader minimum version 1.2 (system disks are also available 
free from your dealer). The latest System 4.0 is shipped with DESKPAK 
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Additional Suggested Hardware 

A second 31/2" disk drive, hard disk drive-or RAM drive. 

• Color or RGB monitor 

Imagewriter II printer (required for print functions) 

Memory Considerations 

The amount of memory you have in your Apple IIGS definitely affects how 
programs run on your system. Some applications require a large amount of RAM 
and leave very little room for desk accessories (NDAs or CDAs). Several 
DESKPAK NDAs are provided for limited memory systems (Calendar and 
Simple Scrap). If you have a limited amount of memory, you should only install 
a few desk accessories. 

Even if you have a lot of memory, you should be aware of the fact that the. menu 
will only display about 15 or so items. For example, if the program you are running 
has About and Help menus under the. menu, there will be room for 13 desk 
accessories. If you have 20 desk accessories on the disk, only 13 would be 
displayed, but all 20 will be in memory! Of course, • Add DA • eliminates this 
limitation and provides access to all of your NDAs! Be wary of how many desk 
accessories you have on your disks. This is very important for those short on 
memory. 

If you are running large programs (such as Paintworks Gold™ which requires 1.2 
meg), we suggest you get a memory card that has more memory than your largest 
program needs. That way you will never have to worry about memory problems. 

If you have a limited amount of memory. and you have installed too many desk 
accessories on the start-up disk, you will know immediately when you try to boot 
the disk, as the Apple IIGS will show an error message. If this happens, remove 
some of the accessories and try again, or add more memory to your system. 
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Program Compatibility 

While testing DESKPAK we found that some programs do not handle desk 
accessories properly and may cause the computer to 'crash' or 'hang' in some 
circumstances. Other programs do not handle Edit menu cutting and pasting 
correctly, and have set up 'private' Clipboards, disregarding desk accessories and 
published guidelines. One manufacturer admits that their program won't work if 
used with desk accessories,and suggests not using desk accessories with it. 

We have also found other public domain and commercial desk accessories that 
do not load the Apple IIGS tools or release memory they've obtained properly, 
wreaking havoc on the system. These offending programs usually do not follow 
Apple Computer's Guidelines. When you ask the producers of such products to 
correct the situation let us know about the problem and solution also. Most· 
software publishers are more than happy to fix bugs in their programs and we are 
no exception. The entire Apple IIGS user community greatly benefits from 
congruous use of programs and desk accessories. 
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Appendix B. Questions and Answers 

This appendix lists some of the most commonly asked questions about 
DESKPAK desk accessories. If you have a question that is not covered here, do 
not hesitate to write or call. 

Installation 

I installed the accessories but they don't show-up in the '* menu. What do I do? 

It is important that you install the accessories correctly. They must be in the 
'DESK.ACCS' folder on your boot disk. Refer to Chapter 1 in this manual for the 
correct procedure. 

After installing the accessories, my computer won't boot. Why? 

If this happens, you will usually get some type of error message. Take the 
accessories off the disk and try installing them one at a time. You probably don't 
have enough memory to use all the accessories (try using '* Add DA '* to 
circ!,Jmvent the problem). If that doesn't work, make sure you didn't delete a 
system file like ProDOS or P16. 

I use a RAM disk. How do I install the accessories? 

If you use your RAM disk as the boot drive, simply follow the same directions for 
installing the accessories on a hard drive. But remember, to boot from the RAM 
disk, you will need all the necessary System Disk files on it too. 
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Finder 

I booted the DESKPAK disk and only ONE desk accessory shows up under the 
• menu. Why? 

The DESKPAK desk accessories, are located in the 'DESKPAK.ACCS' folder. 
Because there are so many desk accessories shipped in DESKPAK, they could 
not all fit under the. menu so we only installed. Add DA •. 

The Finder always opens the 'DESKPAKACCS' folder. Can I change this? 

Yes. Select Preferences from the Finder's Special menu. Change the Save 
Finder Information To Disk option. Then close all the windows. 

Programs 

Why don't the accessories show-up on the Apple II Desktop program? 

The Apple II Desktop was written for ProDOS 8 and uses its own private desk 
accessories. Use the Finder instead. 

When I use some of the accessories with certain programs, why does the 
computer crash? 

The program may not support desk accessories properly. and there is nothing 
you can do about it short of letting the manufacturer know. You could also be 
using an older version of the System Disk. Try copying the application on to a 
disk with GS/OS. 

Also, try booting the DESKPAK disk and run the program from the Finder. If the 
accessories work now, use the Finder to run the program or copy ProDOS and 
the 'SYSTEM' folder over to the program disk. Make sure you do this on a back­
up copy. 
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Why does the. menu extend below the bottom of the screen? 

You have installed too many accessories in the 'DESK.ACCS' folder. Take some 
of the accessories off the disk, or use. Add DA • to access them. 

Why can't I use multiple accessories with my program? 

The program in question didn't follow Apple's Guidelines for program 
development, please let the developers know about the problem. 

DESKPAK Desk Accessories 

Should I install all the accessories on my start-up disk(s)? 

If you want. It is usually better to install each accessory on an individual basis with 
• Add DA •. You can substantially decrease the time it takes the disk to boot by 
only having a few accessories installed on the disk. This effect is less noticeable 
on RAM and hard disks. 

General 

How do I receive updates to DESKPAK? 

You must mail in your registration card. You will be notified of any upcoming 
updates, although sometimes we just send them to surprise you. 

Why does everything seem to work slowly? 

Make sure you have the speed set to Fast in the Apple IIGS Control Panel. 
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I keep running out of memory, what can I do? 

Purchase more memory. If this solution is impractical for you, then delete the 
accessories you don't need from the program disk and use. Add DA •. 
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Appendix C. Technical Specifications 

'* Add DA '* 
Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

Appointments 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

ASCII Chart 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

ADD.DA 
• Add DA • 
Loads and runs New Desk Accessories 
None 
3.5K 
2.4K 

APPOINTMENTS 
Appointments 
Appointment calendar 
'APPOINTMENTS' 
21.0K 
18.3K 

ASCII.CHART 
ASCII.Chart 
ASCII code reference 
None 
5.5K 
4.2K 
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Blackout 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

Calculator 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

Calendar 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

104 

BLACKOUT 
Blackout 
Timed screen protection 
'BO.PARMS· 
3.5K 
3.4K 

CALCULATOR 
Calculator 
Desk calculator 
None 
15.5K 
12.3K 

CALENDAR 
Calendar 
Quick calendar 
None. 
S.OK 
6.5K 



Clipboard 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

Concentrate 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

File Tools 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

DESKPAK DESK ACCESSORIES 

CLIP. BOARD 
Clipboard 
View System clipboard 
None 
4.0K 
2.8K 

CONCENTRATE 
Concentrate 
Entertainment 
None 
12.5K 
10.2K 

FllE.TOOlS 
File Tools 
File manipulation 
None 
15.5K 
12.5K 
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Mini DB 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

Notepad 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

Password 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 
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MINI.DB 
Mini DB 
Database 
'CARD.DECK' 
25.0K 
22.0K 

NOTEPAD 
Notepad 
Notes 
'NOTEPAD.TXT" 
19.0K 
15.7K 

PASSWORD 
Password 
Disk security system 
None 
9.0K 
6.2K 



Print It 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

Puzzle 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

Screen Saver 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

DESKPAK DESK ACCESSORIES 

PRINT.lT 
Print It 
Print Text files 
None 
B.OK 
6.2K 

PUZZLE 
Puzzle 
Entertainment 
None 
7.0K 
5.5K 

SCREEN.SAVER 
Screen Saver 
Save graphic screen to disk 
None 
3.5K 
2.3K 
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Simple Scrap 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

Start Up 

Filename: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

Super Scrap 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 
Memory Used: 

Times 3 

Filename: 
• Name: 
Purpose: 
Default File: 
Disk Space: 

Memory Used: 
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SIMPLE.SCRAP 
Simple Scrap 
Scrapbook 
'SCRAP. BOOK' 
18.5K 
15.7K 

Not a desk accessory 

START.UP 
Show graphic at boot time 
'STARTUP .PIC· 
O.5K 
O.2K (removed after bOot-up) 

SUPER.SCRAP 
Super Scrap 
Scrapbook 
'SCRAP. BOOK' 
32.5K 
28.3K 

TIM ES.3 
Times 3 
3-in-1 clock 
None 
7.5K 
5.7K 
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Glossary of Terms 

o key: The key on the keyboard next to the space bar. 

'* key: Also called the option key. 

'* menu: Menu item where you can find desk accessories. 

active window: The front-most window currently in use. 

application: a program 

ASCII: American Standard Code for Information Interchange 

back-up: A duplicate copy of an original disk. 

button: A control, like a pushbutton on a calculator. 

classic desk accessory: A text-only based desk accessory, available from 
the Control Panel. Also called CDA. 

click: pressing the mouse button on something. 

clipboard: holding area in memory where text or graphics that are cut and 
pasted are kept. 

close box: Icon on the left side of an active window. Closes the active window. 

default file: the file that is used by a DA when it is first opened. 

desk accessory: A mini-program that you can access from a program's '* menu. Also called an NDA. 
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desktop: The I/GS working environment with menu bar and windows 

disk: Magnetic media used for computer program and data storage. 

disk drive: Device which reads and writes data to magnetic storage media. 

drag: To move an object (window, icon) by positioning the cursor on it, holding 
down the mouse button and moving it. 

enable: To activate or make active. 

field: The information area in a database record. 

file: A named collection of stored information on disk or in memory. 

flletype: An attribute further defining a file, such as the NDA filetype. 

finder: A program found on the System Disk to manage files and launch 
programs. 

font: A collection of numbers, letters and other symbols. 

format: Act of preparing a disk so that it can store data. 

GS/OS: Apple's new disk operating system that is compatible with ProDOS 16 
but includes many enhancements. 

hard disk: A mass storage device holding considerably more information than a 
floppy disk. 

highlighting: Visual feedback for a selected item. The object is usually color 
inverted. 

I-beam: A type of cursor indicating where text can be typed. 

Icon: Small picture that represents an object such as a folder icon. 
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Inactive window: A window that has been de-activated by the activation of 
another window. Its title bar will usually be white. 

Initialized disk: A disk that has been formatted and can receive and store 
information. 

Insertion point: A place in text where the next character will be added. 

kilobytes (K): The number of bytes times 1024. In computer terms a kilobyte 
is 1024 bytes (1K = 1024 bytes). 

launch: Refers to starting a program from a Launcher or Finder. 

launcher: A program that launches other programs. The Finder is a launcher 
program. 

lock: To prevent files, disks or systems from being accessible. 

macintosh: The Apple computer that started the desktop revolution. Also 
called a "Mac". 

menu bar: The horizontal "bar" at the top of the Desktop that contains menu 
items. 

menu Item: Item in a menu bar. 

mnemonic: acronym-like representation of a number. 

mode: 320 or 640 super high resolution screen modes refer to 320 or 640 
pixels-per-line, respectively. 

mouse: The hand-held device used for positioning the cursor and selecting 
objects with its button(s). 

new desk accessory (NDA): The type of desk accessory accessible from 
the. menu. 
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ProDOS 8: Apple disk operating system that supports early text based 
programs. 

ProDOS 16: Apple disk operating system that supports new Desktop based 
programs. 

SANE: Standard Apple Numeric Environment. Apple's floating point arithmetic 
routines. 

scrap: A piece of text or picture in a scrapbook. 

scrapbook: A new desk accessory used to store graphic and text "scraps". 

scroll bar: A control that allows horizontal and vertical movement of window 
contents. 

system disk: Disk that contains the operating system (GS/OS), Finder, tools 
and utilities. 

text file: A recognized ASCII file format used by most computers. 

unlnltlallzed disk: A disk that has not been formatted yet. 

write-protected: A disk that cannot be written on. 

zoom box: The small icon on the right-hand side of a window's title bar. It allows 
the window to "zoom" in and out. 

112 



A 

About 
Appointments 17 
MiniDB 47 
Notepad 58 
Simple Scrap 78 

Accessories 
about 1 
accessible from 1 
Appointments 15 
ASCII Chart 21 
Blackout 23 
Calculator 27 
Calendar 33 
CDAs 1 
Clipboard 35 
Concentrate 37 
File Tools 41 
MiniDB 45 
minimum memory 95 
NDAs 1 
Notepad 55 
.Password 63 
Print It 67 
purpose of DAs 1 
Puzzle 69 
Screen Saver 71 
Start Up 73 
Simple Scrap 75 
Super Scrap 83 
llmes3 89 
tiAddDAti 11 

DESKPAK DESK ACCESSORIES 

Index 

Acknowledgements i 
Additional Hardware 96 
Apple Key 

ti key 113 
cj key 113 

Apple Menu 1 
AppOintments 

closing 19 
description 15 
entry of 15 
using 15 

ASCII Chart 
description 21 
opening 21 

B 

Background Functions 
Blackout 25 
Password 65 

Backup Copies 
see Copies 

Blackout 
activating 24 
closing 25 
description of 23 
turning off 25 
using 24 

113 



DESKPAK DESK ACCESSORIES 

Boot 
definition of 5 

Border Flash 
Blackout 24 

c 

Calculator 
clearing errors 31 
clearing memory 30 
description 27 
key descriptions 28 
keyboard equivalents 28 
using 28 

Calendar 
description of 33 

Card Menu 49 
CDAs 

see Accessories 
Changing Pages 

Notepad 57 
Classic Desk Accessories 

see Accessories 
Clipboard 

description of 35 
Colors 

Concentrate 39 
Compatibility 2 
Concentrate 

description of 37 
using 37 

Copies 
backup 4 
extra ii 
illegal ii 

Credits i 

114 

Cut and Paste 
Calculator 28 
Notepad 57 
Simple Scrap 78 
Super Scrap 86 

Default File 
Appointments 15 
MiniDB 45 
Notepad 55 
Simple Scrap 75 
Super Scrap 84 

Delete 
files 41 
Mini DB 51 
Notepad 60 
Simple Scrap 81 
Super Scrap 85 

Delete All 
MiniDB 51 
Notepad 60 
Super Scrap 85 

Delete Menu 19 
Desk Accessories 

see Accessories 
DESKPAKdisk 95 
Disk Protect 64 

E 

Edit Field 50 
Edit Menu 

see Cut and Paste 
Erase Selection 86 
Examples 

Appointments 93 
ASCII Chart 92 
Calculator 91 



everyday 91 
Mini DB 91 
Notepad 92 
Password 92 

Extras Menu 86 

F 

File Menu 
Appointments 18 
MiniDB 47 
Notepad 58 
Simple Scrap 79 
Super Scrap 84 

File Tools 
description of 41 
using 41 

Find 
MiniDB 50 
Super Scrap 85 

Find Again 
MiniDB 51 
Super Scrap 85 

Fit to Selection 86 
Fit to Window 86 

G 

Garnes 
see Puzzle, Concentrate 

Generallnfo 103 
Get 

Appointments 18 
MiniDB 48 
Notepad 58 
Simple Scrap 79 

DESKPAK DESK ACCESSORIES 

Glossary 109 
Guidelines 

H 

desk accessory 1 
program 2 

Halting 25 
Hardware 

see Additional Hardware 

Index 

Info 
description of 4 

Appointments 18 
MiniDB 47 
Simple Scrap 79 
Super Scrap 83 

Installation 

J 

after 10 
description of 5 
on hard or RAM disk 9 
one 3.5" disk 7 
two 3.5" disks 8 
using copy program 10 
using the Finder 6 

JUrT1l To 60 

115 



DESKPAK DESK ACCESSORIES 

L 

Locking Disks 
see Password 

M 

Manual 
assumptions 3 

Master Disk 95 
Memory 96 
Menu Clock 90 
Mini DB 

N 

closing 53 
description of 45 
using 46 

NDAs 
see Accessories 

New 
Appointments 18 
MiniDB 47 
Notepad 58 
Super Scrap 84 

NewCard 49 
New Desk Accessory 

see Accessories 
Notepad 

description of 55 
using 55 

Notes Menu 60 

116 

o 

Order Deck 50 

p 

Pages 
see Changing Pages 

Password 
description of 63 
password entry 63 
using 63 

Paste 
see Cut and Paste 

Peeking 38 
Pictures 

installing startup 73 
Print 

MiniDB 52 
Notepad 60 

Print All 
MiniDB 52 
Notepad 61 

Print It 
description of 67 
using 67 

Print Menu 
MiniDB 52 
Notepad 60 

Problems 97 
Program Switching 

Blackout 24 
Calculator 27 
limes3 90 



Puzzle 

a 

description of 69 
using 69 

Q&A 99 

R 

RAM 
see Memory 

Registered Trademarks 
Registration ii 
Rename 

File Tools 41 
Simple Scrap 81 

Resuming 25 

s 

Save 
Appointments 19 
MiniDB 48 
Notepad 59 
Simple Scrap 79 
Super Scrap 84 

ScrapArea n 
ScrapName n 
Scraps Menu 81 
Screen Saver 

description of 71 
using 71 

DESKPAK DESK ACCESSORIES 

Simple Scrap 
closing 81 
description of 75 
using 76 

Small Clock 90 
Sorting 

see Order Deck 
Start Up 

description of 73 
installing 73 
installing pictures 73 

Super Scrap 
description of 83 
using 83 

Support ii 
System Lock 63 
System Requirements 95 

T 

Technical Specs 
Appointments 103 
ASCII Chart 103 
Blackout 104 
Calculator 104 
Calendar 104 
Clipboard 105 
Concentrate 105 
File Tools 105 
Mini DB 106 
Notepad 106 
Password 106 
Print It 107 
Puzzle 107 

117 



DESKPAK DESK ACCESSORIES 

Screen Saver 107 
Simple Scrap 108 
Start Up 108 
Super Scrap 108 
Times3 108 
tiAddDAti 103 

Technical Support 
see Support 

Text Entry 
Notepad 55 

Time . 
Blackout Delay 24 
Concentrate 39 

Times 3 
description of 89 
using 89 

Tips 
Appointments 20 
MiniDB 53 
Notepad 61 
Password 65 
Simple Scrap 82 
Start Up 83 
tiAddDAti 13 

Title Bar 
Appointments 15 
MiniDB 45 
Notepad 55 
Simple Scrap 76 
Super Scrap 83 

Tools 
Super Scrap 86 

Trademarks 
see Acknowledgements 

Turns 39 

118 

u 

Unlock 
see Password 

Updates ii 

w 

Warranty ii 

tiAdd DAti 
description of 11 
using 12 

ti Menu 
accessories under 1 
Appointments 17 
definition 1 
MiniDB 47 
Notepad 58 
Simple Scrap 78 
Super Scrap 83 



SIMPLE SOFTWARE 

SYSTEMS INTERNATIONAL 

Copyright © 1987, 88 SSSI, Inc. 
All Rights Reserved 

ISBN 0-945-081-00-6 


